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1.1 Introduction

spFrame is a general purpose structural analysis program for two- and three-dimensional 
structures subject to static loads. Written for the Microsoft Windows 3.x environment, it utilizes 
pull-down menus, push-button icons, and dialog boxes for ease of input and clear output 
presentation.

1.2 spFrame Features

spFrame offers flexibility through its impressive array of features which include

• Practically unlimited number of joints and members.

• Second or (P-Δ) effects and tension-only members.

• Proper shear wall modeling.

• Hinged or partially-fixed element ends.

• Shear deformations.

• Translational and rotational elastic supports.

• Inclined supports.

• Rigid-end offsets.

• Rigid diaphragms.

• Non-prismatic members.

• Loads may be applied to

Members–as point (force or moment), uniform, and triangular loads.
Members–as caused by temperature effects.
Joints–as forces, moments, and known displacement

spFrame has a fast sophisticated graphic interface that displays the modeled structure, the input 
loads, the deflected shape, and the resulting moment and shear diagrams. The graphic interface 
allows zooming, translating, rotating, and selective viewing of the graphical image.

1.3 spFrame Features

spFrame includes a graphic editor that allows you to prepare input for the spFrame program. It 
enables you to generate the model by drawing it directly on the screen and, using the same graphic 
interface, assign all joint and member properties and loads quickly and easily.
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spFrame has a sophisticated graphics interface that allows you to create the modeled structure 
using a planar editor, generate more planes at any offset or any rotation, and then graphically 
assign joint and member properties.

spFrame offers the option of generating lateral loads (wind and seismic) for a building structure in 
conformance with the three major U.S. codes and the Canadian code. In addition, surface (area) 
loads may be graphically input to be converted to uniform member loads. The tributary areas and 
the live load reduction factors for the members can also be computed.

1.4 Program Capacity

The size of a problem that can be solved using spFrame depends on the available amount of 
memory and hard disk space. However, the following limitations are set in the program.

• Maximum number of joints: 30,000

• Maximum number of members: 32,767

• Maximum number of material entries: 1,000

• Maximum number of section entries: 1,000

• Maximum number of nonprismatic entries: 1,000

• Maximum number of load entries: 1,000

• Maximum number of load cases: 120

1.5 System Requirements

Any computer running Microsoft Windows XP or Vista is sufficient to run spFrame. Please refer 
to our Setup and Licensing Guide for instructions on how to troubleshoot Vista related issues.

https://www.structurepoint.org/setup_licensing/index.htm#t=home.htm


INTRODUCTION

| 16 |

1.6 Terms

The following terms are used throughout this manual. A brief explanation is given to help 
familiarize you with them.

Windows refers to the Microsoft Windows environment as listed in Operating 
System section of System Requirements.

[ ] indicates equivalent value expressed in metric unit or CSA code 
requirement corresponding ACI code requirement

Click on means to position the cursor on top of a designated item or location and 
press and release the left-mouse button (unless instructed to use the right-
mouse button).

Double-click on means to position the cursor on top of a designated item or location and 
press and release the left-mouse button twice in quick succession.

Marquee select means to depress the mouse button and continue to hold it down while 
moving the mouse. As you drag the mouse, a rectangle (known as a 
marquee) follows the cursor. Release the mouse button and the area inside 
the marquee is selected.
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1.7 Conventions

Various styles of text and layout have been used in this manual to help differentiate between 
different kinds of information. The styles and layout are explained below…

1.8 Installing, Purchasing and Licensing spFrame

For instructions on how to install, purchase and license StructurePoint software please refer to our 
Setup and Licensing Guide.

Italic indicates a glossary item, or emphasizes a given word or phrase.

Bold All bold typeface makes reference to either a menu or a menu item 
command such as File or Save

Mono-space indicates something you should enter with the keyboard. For example type 
“c:\*.txt”.

KEY + KEY indicates a key combination. The plus sign indicates that you should press 
and hold the first key while pressing the second key, then release both 
keys. For example, “ALT + F” indicates that you should press the “ALT” 
key and hold it while you press the “F” key. Then release both keys.

SMALL CAPS Indicates the name of an object such as a dialog box or a dialog box 
component. For example, the OPEN dialog box or the CANCEL or MODIFY 
buttons.

https://www.structurepoint.org/setup_licensing/index.htm#t=home.htm
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2.1 Model

spFrame is used to analyze two and three-dimensional frame or truss structures subjected to static 
loads.The structure to be analyzed must be reduced to a mathematical model represented by 
straight lines. These lines are referred to as members. Member ends are referred to as joints or 
nodes.

Joints and members are assigned physical properties to simulate the real structure. A joint can be 
assigned properties such as restraining its rotation about a particular direction, restraining its 
movement in a particular direction or to a certain path, controlling the magnitude of its movement, 
or rotation, if a force or moment occurs at that joint. A member is assigned location, orientation, 
material properties and section properties.

Further refinement of the mathematical model can be achieved by the simulation of non-prismatic 
members, applying member end partial releases, accounting for rigid end offsets, shear 
deformations, and the stiff diaphragm action.

Loads are applied to members (in the form of forces, moments, or temperature effects) and to 
joints (in the form of forces, moments, or known displacements). Loads are categorized into load 
cases that can be factored and combined under load combinations. The modeled structure is then 
analyzed under these load combinations and the resulting forces, moments, displacements, and 
rotations are presented for each load combination.

2.2 Global Coordinate System

Joint definitions, assignments, and results (such as coordinates, fixities, inclined supports, 
reactions, displacements, rotations, etc.) are based on the global coordinate system. spFrame uses 
the right-hand rule convention to define the global coordinate system. Looking at the display 
monitor, the origin of the global coordinate system is located in the bottom left corner of the 
screen. The positive X axis points to the right, the positive Y axis points upward towards the top 
of the monitor, and the positive Z axis points out of the screen. Thus, the XY plane is defined as 
being the plane of the display monitor.
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Figure 2.1 Global Coordinate System

The right-hand rule states that if the thumb, index finger, and middle finger of your right hand are 
all positioned at right angles to each other, they form the X, Y, and Z axes, respectively. It is 
evident that this system can be rotated in any direction, and the XY plane does not necessarily lie 
in the plane of the monitor. However, the direction of the axes relative to each other must always 
remain the same.

For moments and rotations, if the thumb of your right hand points in the positive direction of an 
axis, curling the rest of your right-hand fingers defines the positive moment or rotation about that 
axis.

2.3 Local Coordinate System

Member definitions, assignments, and results (such as orientation, moments of inertia, deflections, 
forces, moments, etc.) are defined based on the local coordinate system. spFrame uses the right-
hand rule convention to define the local coordinate system. A member location is defined by a 
start joint and an end joint (a start joint is sometimes referred to as J1 or i-end, and an end joint is 
sometimes referred to as J2 or j-end). The member positive local x axis points from its start joint 
towards its end joint and the local y and z axes are defined using the right-hand rule.
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Figure 2.2 Local Coordinate System

For example, for a horizontal member (positive local x-axis is parallel to the positive global x-
axis) in space, the positive local y and z axes are parallel to the positive global Y and Z axes, 
respectively.

For moments or rotations, the right-hand rule explained in Global Coordinate System applies.

2.3.1 Orientation

The position of a straight prismatic member in space is therefore defined by the global coordinates 
of the joints at each end, and its orientation in space is defined by the orientation angle, β. For a 
horizontal member in space (a member whose positive local x axis is parallel to the positive global 
X-axis), the positive local y axis is defined as the vertical axis perpendicular to the local x axis 
pointing up. The local z axis is the axis perpendicular to the local xy plane. The orientation angle 
is the clockwise angle, measured in degrees, between the default local y-axis that spFrame 
assumes and the member minor axis, yo.

 



MODEL STRUCTURES IN spFrame

| 24 |

Figure 2.3 Member Orientation Angle

Figure 2.4 Member Orientation Angle

2.4 Numbering Scheme

spFrame must keep track of all input joints and members along with their properties and loads. For 
this reason, each entry (joint, member, property, load, etc.) must be identified with a unique 
identifier or label. In most analysis programs, this is usually done by assigning sequential numbers 
to the different entries. However, spFrame allows you to assign meaningful labels (alpha, numeric, 
or alpha numeric labels), to the entries. You can assign a “Bm12” or Col51” label to a member, 
“Corner1” label to a joint, “Point12” or “Snow1” labels to a load, “D+L+W” label to a load 
combination, and so forth. Note that labels are case sensitive, “SELF”, “Self”, and “self” are three 
different labels.

By default, spFrame uses numerical labels for joints and members. The program increments the 
number value of the label by one, after you add a joint or member.

 

 



MODEL STRUCTURES IN spFrame

| 25 |

2.5 Units of Measure

spFrame gives you the flexibility of selecting the units of measure to be used for input and output. 
You can choose either the English (U.S. Customary) system or the Metric (SI) system. For either 
system, select the units to be used for member length, section dimensions, area, moment of inertia, 
spring translational stiffness, spring rotational stiffness, modulus of elasticity, material density, 
point load, moment load, distributed load, known displacement, shear or axial load results, 
moment or torsion results, and deflection results.

If units are changed during the course of inputting a problem, or after solving it, spFrame makes 
the necessary conversions to the already input data and the output results.

2.6 Structure Types

The structure type is determined by the type of members used to model it. There are four types of 
members in spFrame. Members include 2-D Frames, 3-D Frames, 2-D Trusses, and 3-D Trusses. 
They differ from each other by the number of degrees of freedom per joint. A degree of freedom 
refers to the direction in which the joint can move or rotate.

Two-dimensional plane frame members have three degrees of freedom per joint displacement in 
the global X direction, displacement in the global Y direction, and rotation about the global Z-
axis. Plane frame members can be subjected to in-plane loads that can cause axial, shear, and 
bending stresses.

Three-dimensional space frame members have six degrees of freedom per joint displacements in 
the global X, Y, and Z directions, and rotations about the global X, Y, and Z axes. Space frame 
members can be subjected to forces and moments in any direction.

Two-dimensional plane truss members have two degrees of freedom per joint— displacement in 
the global X direction and displacement in the global Y direction. By definition, trusses are loaded 
only at the joints so that members are subjected to axial forces only (no bending moments or 
shears). Although member loads can be applied to truss members in spFrame, these loads are 
converted to equivalent joint loads before the structure is solved.
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Figure 2.5 

Three-dimensional space truss members have three degrees of freedom per joint displacement in 
the global X direction, displacement in the global Y direction, and displacement in the global Z 
direction.

2.7 Material Properties

Materials are defined by inputting their properties. These materials can then be assigned to the 
various members. A DEFAULT material, whose properties are assigned to all the members that do 
not have any materials assigned to them, can also be defined. Each material has the following 
properties

Material density, d, is the unit weight of the material. It is used to calculate the self weight of the 
members.

Modulus of Elasticity, E, represents the behavior of a material in the linear region of its stress-
strain curve.

Poisson’s Ratio, v, is the ratio of the strain in the lateral direction to the strain in the axial direction. 
A typical value is 0.20 for concrete, 0.30 for steel, and ranges between 0.25 and 0.35 for most 
metals.

Thermal Coefficient, a, is a measure of the degree of expansion or contraction of a material when 
subjected to a unit change in temperature. This coefficient is needed when temperature loads are to 
be considered.
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2.8 Section Properties

Sections are defined by inputting their properties. These sections can then be assigned to the 
various members. A DEFAULT section, whose properties are assigned to all the members that do 
not have any sections assigned to them, can also be defined. 

The section properties needed depend on the type of section selected. Figure 2-6 shows the 
available section types and the associated properties needed. Note that section properties can be 
saved in libraries to be shared by other files. Therefore, even properties that may not apply to the 
current structure type must be input.

The analysis is done based on the properties of the gross section. However, in concrete structures, 
you may want to base the analysis on the cracked section properties. In this case, you may input 
cracked-section coefficients that will be multiplied by the applicable section area (A), in-plane 
moment of inertia (Iz), out-of-plane moment of inertia (Iy), and the polar moment of inertia (J). 
The resulting properties are then used in the analysis. Note that the self weight of a member is 
based on its gross sectional area regardless of the coefficients input.

Figure 2.6 Section Properties
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2.9 Joints

The first step in defining the model geometry after selecting a structure type is inputting the joints. 
Joints are defined by their coordinates and properties. It is recommended that joints be defined 
starting with the lowest plane, moving in the positive global X direction until a whole row or line 
of joints is defined. Then move towards the positive global Z direction, one row at a time, until the 
whole XZ plane is defined. Move up in the positive global Y direction, one plane at a time, until 
the whole model is defined.

2.10 Coordinates

Joint coordinates are referenced from the global coordinate system. For plane (2-D) structures, an 
X and a Y coordinate are needed to define a joint location in a plane. For space (3-D) structures, 
three coordinates (X, Y, and Z) are needed to define a joint location in space.

2.11 Joint Generation

After the first joint is defined, a whole row of joints can be created by generating multiple copies 
of the first joints while incrementing one or more of its coordinates. Similarly, a row (or line) of 
joints can be copied several times to generate a plane of joints. For example, joints 2 through 5 in 
Figure 2-7 Joint Generation (a) are generated by copying joint 1 four times while incrementing its 
X coordinate by the value Δx. Similarly, joints 6 through 15 in Figure 2-7 (b) are generated by 
copying joints 1 through 5 twice while incrementing their Z coordinate by the value Δz. Joints 16 
through 45 are generated by copying joints 1 through 15 twice while incrementing their Y-
coordinate by the value Δy.

Generated joints are labeled with sequential numbers starting with the number of joints already 
input prior to the generation process. If for some reason, a generated joint label is already used, an 
underscore (_) followed by a number is appended to the label.
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Figure 2.7 Joint Generation

2.12 Fixities

Initially, all joints are assumed to be free. In other words, they are free to move along or rotate 
about the active axes. A fixed or restrained joint (support) is a joint that has one or more of its 
active degrees of freedom restrained.

For 2-D truss structures, joint displacements along the X and Y axes can be restrained. For 2-D 
frame structures, joint rotation about the Z axis, as well as its displacements along the X and Y 
axes can be restrained. For 3-D truss structures, joint displacements along the X, Y, and Z axes can 
be restrained. For 3-D frame structures, joint displacements along the X, Y, and Z axes, as well as 
its rotations about the axes can be restrained.
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2.13 Inclined Supports

Fixed joints (supports) are assumed to be vertical or horizontal (parallel to one of the global axes). 
There are cases, however, when the support is inclined, e.g., when the foundation of a structure 
rests on a sloped surface rather than on a flat surface.

To define an inclined support, its inclination angle(s) from the global axis (or axes) must be input. 
The joint specified as an inclined support will then have its global axes rotated by the specified 
angle(s), and the support reactions will be presented with respect to the rotated axes.

For plane (2-D) structures, an inclination angle measured clockwise from the global X axis must 
be input. For space (3-D) structures, two inclination angles, measured clockwise, one from the 
global X axis and the other from the global Z axis must be input.

Figure 2.8 Inclined Support Angle

2.14 Spring Supports

Structural supports that can deform are referred to as elastic supports or spring supports. When 
designating spring supports, the program will add the appropriate stiffness terms, representing the 
spring stiffness, to the global stiffness matrix directly.

Spring supports can be translational (linear) or rotational. They are defined by inputting their 
corresponding spring constants related to the active degrees of freedom. kx, ky, and kz denote the 
translational spring constants in the X, Y, and Z directions, respectively. kRx, kRy, and kRz denote 
the rotational spring constants about the X, Y, and Z axes, respectively. Truss structures can have 
translational spring supports only, while frame structures can have both translational and 
rotational spring supports.
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2.15 Members

Member connectivity, i.e., the location of the member in a plane or space, is defined by inputting 
the two joints that the member connects. These joints are referred to as the start joint, J1, and the 
end joint, J2. The start and end joints of a member are used to define the direction of the member, 
its local coordinates, the direction of the local loads, and are referenced in presenting the member 
local results.

For ease of input and result interpretation, it is recommended that you try to define members in 
such a way that the positive local X axis of a member is parallel to one of the positive global axes. 
This way, horizontal members will have their x axis pointing from left to right (parallel to the 
global X axis) or out of the monitor (parallel to the global Z axis). Vertical members will have their 
x axis pointing from bottom to top (parallel to the global Y axis). Note that this is just a 
recommendation and not a rule. For inclined members, judgment must be used in defining the 
members, but try to keep the member definition consistent for the whole model.

The order in which members are input can simplify or complicate the process of member 
assignments, member grouping, and interpretation of results. It is good practice to define all 
vertical members in sequence, then define all horizontal members in sequence, and finally define 
any inclined members.

When defining the horizontal members, start at the bottom of the model, moving towards the 
positive global X direction first, until a whole row of members is defined. Next, move in the 
positive global Z direction, one row at a time, until a whole plane is defined. Finally, move in the 
positive global Y direction, one plane at a time, until all vertical members of the model are 
defined. Define the vertical members, followed by any inclined members if they exist, in the same 
order, moving in the positive X direction, the positive Z direction, and finally in the positive Y 
direction.

2.16 Member Generation

After the first member is defined, a whole row of members may be created by making multiple 
copies of the first member while incrementing its start and end joints (J1 and J2). For example, 
members 2 through 5 in Figure 2-9 are generated by copying members 1 four times, while 
incrementing its J1 and J2 by the value 1. Similarly, members 6 through 10 in Figure 2-9are 
generated by copying members 1 through 5 once, while incrementing their J1 by 31 and their J2 
by 19.
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Figure 2.9 Member Generation

Generated members are labeled with sequential numbers starting with the number of members 
already input prior to the generation process. If for some reason, a generated member label is 
already used, an underscore (_) followed by a number is appended to the label.

2.17 Member Assignments

Material properties, section properties, and non-prismatic member definitions are defined, stored 
in databases, and then, along with an orientation angle, are assigned to the members. The 
DEFAULT values of material properties, section properties, and orientation angle are assigned to 
those members with no such assignments.

2.18 Refine model

In spFrame, the structure is reduced to a model consisting of joints and members. Joints represent 
the intersection of the geometric centers of the structural members, and members are straight lines 
representing the centerlines of the structural members. The analysis is then performed on this 
centerline-to-centerline geometry and the resulting end forces are presented at the joints. spFrame 
allows you to apply some refinement to the model to compensate for these approximations.

2.19 Non-prismatic members

The formulation of the member stiffness matrix is based on prismatic members (members of 
constant cross section along the member length). The stiffness coefficients of the flexural member 
matrix Kii, Kjj, and Kij are 4, 4, and 2, respectively. spFrame gives you the option of modifying 
these stiffness coefficients to model non-prismatic members. The stiffness coefficients for non-
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prismatic members, such as arched or haunched beams, can be obtained from various engineering 
publications dealing with the subject.

2.20 Partial Releases

Frame members are assumed to have complete continuity at their end joints (rigid joints) so that 
the bending moment at the joint is fully transferred to the other connecting members based on their 
relative stiffnesses. There are cases, however, when the connection may not be able to develop full 
continuity of the connecting members, or when the moment at a connection must be distributed to 
the connecting members in specific pre-determined ratios.

Figure 2.10 Member-end Releases

Such cases can be modeled by assigning a release factor at either or both ends of a member to 
specify its continuity or how much moment release should be allowed at its end. The release factor 
can be any value between 0 and 100, where 0 denotes a fixed end condition and 100 denotes a 
hinged end condition. A fixed member end (release factor equals 0) allows distribution of the 
moment at the joint to the connecting members based on their relative stiffnesses. A hinged 
member end (release factor equals 100) allows free rotation of that member at that end and no 
moment will be transferred to the connecting members. A partially released member end (release 
factor greater than 0 and less than 100) allows some rotation of the member at that end and the 
specified amount of moment will be released to the connecting members

2.21 Shear Corrections

Both flexural and shear deformations may be considered. Flexural deformations are more 
significant in members with large shear span-to-depth ratios (long members), while shear 
deformations are more significant in members with small shear span-to depth ratios (short or 
stocky members).

For most cases, shear deformations can be ignored. However, in members such as shear walls or 
deep beams where the depth of the member is significant in comparison to its shear span (M/V), 
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shear deformations become more significant. Shear deformations are based on the effective shear 
area, As, which is equal to the area of the member cross section, A, divided by the shear shape 
factor, B. Shear shape factors are presented in Figure 2-11.

Figure 2.11 Shear Correction Shape Factors

2.22 Rigid-End Offsets

In general, ignoring the finite dimensions of structural members may result in overestimation of 
deflections and underestimation of member end force. Rigid-end offsets of a member may be 
included by inputting the half-widths of the member supports (See Figure 2-21). These half-
widths of the supports are taken into consideration when calculating the clear span. The portion of 
a member within the wide support is considered infinitely rigid. The results of a member with 
rigid-end offsets are output at the face of the designated supports (rather than at the end joints).
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Figure 2.12 Member Rigid-End Offsets

2.23 Rigid Diaphragm

In structural analysis of buildings subject to lateral loads, concrete floor slabs are usually 
considered to be infinitely stiff in their own plane. This assumes that floors displace as rigid bodies 
and the story shears and torsional moments are distributed to the vertical members (columns and 
walls) in proportion to their relative stiffnesses.

Modeling of rigid diaphragms in spFrame may be done by attaching infinite in plane stiff beams to 
the floor diaphragms. These members will share the same in-plane degrees of freedom and will 
move as a rigid body in the X-Z plane.

2.24 Loads

Loads can be applied to members in the form of forces, moments, and temperature effects, and to 
joints in the form of forces, moments, and known displacements. All applied loads must be 
categorized into load cases that can then be factored and combined into load combinations. The 
modeled structure is finally analyzed under these load combinations and the resulting forces, 
moments, displacements, and rotations are presented for each load combination.

2.25 Member Loads

Member loads (see Figure 2-13) can be point loads, distributed (uniform), moment (concentrated), 
left triangle, right triangle, and temperature loads. For the first five types, the orientation, 
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direction, magnitude, point of application, and length of load (if applicable) must be defined. For 
temperature loads, the change in temperature and the distance between two surfaces must be input.

Member loads can be defined in the local (member) coordinate system, the global coordinate 
system, or acting on the global projection of the member. The direction of a load is one of the axes 
in reference to the orientation that is specified. Loads are considered positive if they act in the 
positive direction of an axis regardless of the orientation. In the local orientation, a rule of thumb 
is that positive loads tend to rotate the member counter-clockwise about its end joint (J2).

The intensity of a load is its magnitude. For left- or right-triangular loads, it is the magnitude of the 
load at the right end, or at the left end, respectively.

The point of application of a load is input as a ratio of the load location from joint J1 to the 
member length. Similarly, the length or extent of a load (uniform and triangular loads) is also input 
as a ratio of the load length to the member length. This way, a load can be applied to several 
members regardless of their length, and no change to the load data is required if the member 
length changes.

Temperature loads can be used to analyze the behavior of the structure when members are subject 
to a change in temperature. Change in temperature can be uniform on all the surfaces of a member 
(e.g. when the ambient temperature around the member changes). In this case, the member is 
subjected to axial stresses caused by its expansion or contraction. The change in temperature can 
also be different for opposite sides of a member (e.g. when the sun shines on one surface while the 
other surface is in the shade), in which case the member is subjected to bending, in addition to 
axial stresses due to the differential expansion or contraction of the two surfaces.
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Figure 2.13 Types of Member Loads

To define a temperature load, you need to input the member thickness or the distance between the 
two surfaces that experience change in temperature, the top or right surface (Δtop), and the bottom 
or left surface (Δbot). The top surface refers to the member side that has the lower local y-
coordinate. The right surface (for space frames only) refers to the member side that has the lower 
z-coordinate.

2.26 Joint Loads

Joint loads can be forces, moments, known displacements, and known rotations. All joint loads 
can be applied in the direction of or about the active axes of the global coordinate system.

2.27 Solver

spFrame has a two-pass solver using the stiffness method of analysis. The first pass can be 
performed after the model geometry is defined. The program computes the element stiffness 
matrices and builds the associated global stiffness matrix of the whole structure. The element 
stiffness matrix is a square matrix proportional to the member degrees of freedom (e.g. a plane 
truss element stiffness matrix is 4 x 4, whereas a space frame element stiffness matrix is 12 x 12). 
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The element stiffness matrix is then multiplied by the applicable transformation matrices to 
account for member orientation and any special corrections.

The second pass can be executed after the applied loads and the corresponding load combinations 
are defined. The program builds the load matrix, inverts the global stiffness matrix, builds the 
displacement matrices, and solves for the joint displacements, joint reactions and member end 
forces. Therefore, the structure can be analyzed under different sets of loads and/or load 
combinations without having to recalculate the stiffness matrices again

When executing the solver for the first time for a particular problem, a first-order analysis is 
performed and the resulting joint displacements, joint rotations, support reactions, and member 
end forces are computed. To compute secondary P-Δ effects or to solve for tension-only members, 
a second run must be executed. This second run is necessary because the solver needs some results 
from the first run. In a second-order analysis, members designated as tension-only members will 
be removed from the model if they are subjected to any compressive loads.

2.28 Optimization

The size of the global stiffness matrix, and consequently the time needed to solve the problem and 
the amount of memory and disk space needed, is proportional to the number of joints in the model 
and the degrees of freedom per joint. The global stiffness matrix is symmetrical about the 
diagonal, and many of its terms away from the diagonal have a zero value. These zero-value terms 
are ignored in the calculations, and only the terms within a narrow bandwidth of the diagonal are 
hence used. The bandwidth is in turn proportional to the maximum difference between joint 
numbers of any two joints connecting a member and the number of degrees of freedom per joint. 
The equation describing this relationship is

Bandwidth = dof (1 + nd) where,

dof = the number of degrees of freedom per joint,

nd = the maximum difference between joint numbers of any two joints connecting a 
member.

For example, if a space frame (dof = 6) has several members, one of which connects joints 3 and 
12, nd would be 9, and the resulting bandwidth is 60. On the other hand, if the joints of the same 
frame are to be renumbered so that the same member connects joints 3 and 5, the bandwidth will 
be reduced to 18, less than one third the original bandwidth. Note that a joint number refers to the 
order that a joint is input and not the label of the joint.

You can instruct the program to optimize your model prior to executing the solver. Optimization is 
done by selecting a starting joint, assigning the number 1 to that joint, and building the rest of the 
model from there. All subsequent joint numbers will be assigned as needed to keep the bandwidth 
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to a minimum, i.e., joint numbers will be chosen in such a way that the difference between two 
joints at each end of a member is kept to a minimum. Selecting the starting joint can be left to the 
program, in which case it will select the joint with the smallest X, Y, and Z coordinates, or by 
designating a particular joint as a starting joint.

Note that the renumbering of the joints during optimization is an internal one and will not affect 
the labels of the defined joints or members.

2.29 Precision

spFrame uses double precision numbers. Double precision numbers have 15-digit accuracy and 
their values can be between 1.7 x 10-308 and 1.7 x 10308.

2.30 Solver Messages

spFrame’s solver has several built-in checks that are performed before and during the solution 
process. These checks are

• Joint consistency—The program checks to make sure that each joint has a unique label 
and no joint is input more than once.

• Member consistency—The program checks to make sure that each member has a unique 
label and unique start and end joints.

• Valid fixities—The model must have at least one defined fixed joint. If no fixed joints 
were defined, the model will be unstable and an error condition will occur.

• References—All referenced joints, members, fixities, physical properties, loads, load 
cases, and load combinations must exist.

• Definitions—All defined properties (materials, sections, and non-prismatic members), 
loads, load cases, and load combinations must have unique labels. Blank labels are not 
permitted.

• Loads—Member loads direction must be legible within the structure type. Out-of plane 
loads are not allowed in plane structures.

• Single structure—The model being analyzed must constitute a single, independent, and 
stable structure.

• Weak Structure—It is possible to combine the various features of spFrame in such a way 
that the resulting model would be unstable despite passing all the built-in checks 
mentioned above. A Weak Structure error is usually caused by very small numbers in the 
diagonal of the global stiffness matrix. Incorrect assignments of joint fixities, partial 
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releases, inclined supports, physical properties, etc., can cause such an error. In this case, 
the input data must be checked for any flaws that cause instability.

2.31 Results

After a successful solution of the model you will be able to view and/or print the results in text or 
graphical format. Comprehensive text printing can be done from the File/ Print Results command. 
Viewing and printing of summaries and individual tables and graphs is done using the Joint 
Results, Support Reactions, Member Results, Envelopes, and Group Results commands from the 
Analyze menu. Viewing results diagrams superimposed on the graphical model can be done from 
the Show/Result Diagrams command, and printing those superimposed results can be done from 
the File/Print Screen command.

The active printer or printer settings can be changed from the File/Printer Setup command. The 
available options depend on the printer/plotter drivers that were selected during Windows 
installation. You can change the resolution of your printout (dot matrix and laser printers), the 
page orientation (landscape or portrait, laser printers only), or define the media and pen types 
(plotters). Note that the higher the resolution, the longer it will take to print a page.

Joint displacements, rotations, and reactions (forces and moments) are referenced in the global 
coordinate system. Member end forces and moments as well as the segmental values of member 
forces, moments, and deflections are referenced in the member local coordinate system.

When interpreting member results, the member should be considered as a free body and the forces 
and moments calculated at its ends are the member reactions to the applied loads. For example, a 
positive axial force, Fx, at joint J1 and a negative axial force at joint J2, indicate that the member 
is in compression. Moments of opposite signs at each end of a member indicate that the member is 
bending in single curvature while moments of the same sign indicate double curvature bending.

Static equilibrium of the members and the structure as a whole must be maintained. The 
summation of all the end forces (or moments) of all the members framing into a joint, keeping in 
mind the different orientation of the framing members, must be equal to zero (within the bounds of 
round-off or truncation errors)

2.32 Comprehensive results

Text results that include an input echo may be printed using the File/Print Results command. 

Input echo consists of three options. These include definitions, geometry, and loads data. The 
definitions option includes the applicable of the following: general information, units, defaults, 
material definitions, section definitions, non-prismatic member definitions, load definitions, 
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defined load cases, and defined load combinations. The geometry option includes the applicable 
of the following: joint coordinates, joint fixities, inclined supports, spring supports, member data, 
member partial releases, member shear correction factors, member rigid-end offsets, rigid 
diaphragms, and member groups. The loads option includes the applicable of the following: 
member loads, joint loads, known displacements, and member self loads.

The results option includes the applicable of the following: joint displacements, joint rotations, 
support reactions, member end forces, member end moments, diaphragm displacements, member 
summary, segmental values, envelope results, and group results. All or each of these results 
options can be printed for all or just selected joints, members, load combinations, or member 
groups.

2.33 Individual results

Text and graphic results for individual members under each load combination may be viewed and/
or printed using the Joint Results, Support Reactions, Member Results, Envelopes, and Group 
Results commands from the Analyze menu.

Joint results include the applicable joint displacements (Dx, Dy, and Dz), joint rotations (Rx, Ry, 
and Rz), end forces (Fx, Fy, and Fz), and end moments (Mx, My, and Mz) at all joints.

Support reactions include the applicable reactions, forces and moments (Fx, Fy, Fz, Mx, My, and 
Mz), at all supports or fixed joints.

Member results include the applicable segmental values of the forces, moments, and deflections 
along the member length with their corresponding diagrams as well as a member summary. 
Segmental values are obtained by dividing the member into 100 segments, taking the values at the 
start joint (J1) as the initial values, and, using trapezoidal integration, calculating the forces, 
moments, and deflections at each location. Member summary is a one-page information sheet that 
provides all the input information for a member along with its end forces and moments and the 
maximum and minimum values for the member forces, moments, and deflections.

Envelope results include, for each member, the maximum and minimum values of the member 
forces and moments resulting from all defined loading combinations along with the corresponding 
diagrams.

For each defined member group, results include maximum and minimum values of the force and 
moment envelopes for all members in the group with the corresponding diagrams.
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2.34 Superimposed graphs

Result diagrams superimposed on the displayed model can be viewed using the Show/ Result 
Diagrams command and printed using the File/Print Screen command. Superimposed results can 
be deflections, shear diagrams, or moment diagrams.
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3.1 Introduction

This chapter is divided into sections that follow the order that commands and options appear under 
the menu items.

3.2 spFrame Window

Most windows have certain components in common, such as a title bar and menus. Not all 
windows, however, have every component. To learn more about how to use window 
components, refer to your Microsoft Windows manual. The following is a list of the spFrame 
window components.

Control-menu box

Control-menu box is located in the upper-left corner of a window and includes commands for 
sizing, moving, enlarging, restoring, and closing the window, as well as switching to other 
applications. To access the Control-menu box using the mouse, click the left-mouse button on 
the box. To access the Control-menu box using the keyboard, press ALT + - (hyphen).

Minimize/Maximize buttons

These buttons are located in the upper-right hand corner of a window. Minimize button 
(represented by a flat line) shrinks the spFrame window to an icon. Maximize button 
(represented by a square) enlarges the window so that it fills the entire desktop.
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Figure 3-1 spFrame Window

Title Bar

Title bar displays the name of the application or document (spFrame in thiscase) along with 
the name of the current data file you are using. If the data you are working on have not been 
saved into a file, the word “Untitled” is displayed in the Title bar.

Menu Bar

Menu bar is located directly below the Title bar and lists the available menus. A menu contains 
a list of commands and options you may execute using the program. In spFrame there are eight 
main pull-down menus. Menus include File, Access, Define, Process, Analyze, Show, 
Options, and Help.

Tool bar

Tool bar is located on the left side of the spFrame window and contains a collection of icons 
(or buttons) that provide you with a shortcut to accessing the various commands and options. 
Tool bar consists of three major sections. The top section shows the global axis orientation of 
the structure, the middle section contains eight icons that represent the pull-down menus, and 
the bottom section contains up to twelve icons that represent the commands or options 
available.

Graphics area

Graphics area covers most of the spFrame window. This is where the graphical model of the 
structure will be displayed.
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3.3 spFrame Menu Descriptions

spFrame uses pull-down menus that access commands and options for modeling the structure, 
manipulating the look of the program window, running the program, and reviewing and printing 
the results. If you are using a mouse, you will be able to access these commands and options by 
clicking on the icons located in the Tool bar. This section gives you a summary of each command 
in all the pull-down menus.

3.4 File Menu

File menu is used for opening, saving, and retrieving data files, printing 
results, and exiting the program.

New

Clears any input data and returns the program to the default values so 
that a new data file may be started.

Open

Allows you to load an existing spFrame data file.

Save

Saves the changes you have made to the current data file under that 
same filename. The new data overwrites the old data, and you cannot retrieve the old data. 
Save command will only be available if the file has been modified since the last file save. If a 
data file is untitled, the SAVE AS dialog box will appear.

Save As

Allows you to name or rename a data file. Use Save As when you want to save both the 
original data and any changes you’ve currently made to the data. The original data remains 
under the old filename. If a file of the same name exists, the program will ask if you would like 
to overwrite the file.

Import

Imports an existing drawing created or edited using AutoCAD with a .DXF file format into the 
file being edited

Export

Saves the model geometry defined in the current data file to an AutoCAD file (with a .DXF 
extension).
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Revert

Used to discard any changes to the data and return to the version of data saved in the original 
file. This option will only be available if the file has been modified since the last file save and 
the file has been saved prior to editing.

Print Results

Allows you to send the results of a successful run to the printer.

Print Screen

Allows you to print the graphical image displayed in the Graphics area of the spFrame 
window.

Exit

Ends the spFrame session and returns you to the Program Manager. If you have made any 
changes to your data and have not saved them, spFrame will ask whether you want to save or 
abandon any changes you’ve made before you exit.

3.5 Access Menu

Auto Input

This command is designed to make the input process easier. By selecting 
Auto Input, a logical sequence of dialog boxes will automatically be 
displayed allowing you to enter data needed to model your structure. 

Library

Creates new libraries or includes existing libraries in the current file for 
materials, sections, member loads, and non-prismatic members.

Copy

Sends a copy of the graphic image displayed on your window to the Clipboard.

Settings

Allows you to change the settings for the angle of separation used while viewing the structure 
in stereoscopic 3-D format.

Statistics

Provides information such as the structure type, number of joints, number of members, amount 
of memory used, and the amount of memory available.
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3.6 Define Menu

Define menu contains commands that define the databases of the 
physical properties of the structure and the applied loads. 

Type

Allows you to define the structure type (2-D or 3-D frame or 
truss), and input labels for the project and the engineer.

Units

Allows you to select a system of units to be used. Your choices 
are English or Metric. For the system selected, specify the units to be used with the different 
input and output parameters.

Defaults

Allows you to input the default values for the material and section properties. These default 
values will be assigned to members with no defined material or section properties.

Materials

Allows you to define new materials, or edit existing ones, and input their properties. A 
material entry consists of label, density, modulus of elasticity, Poisson’s ratio, and thermal 
coefficient.

Sections

Allows you to define new sections, or edit existing ones, and input their properties. A section 
entry consists of label and, depending on the section type, section dimensions or properties.

Nonprismatic Members

Allows you to define new non-prismatic members, or edit existing ones, and input their 
properties. A nonprismatic member entry consists of label, the stiffness factors at member 
ends, and the carry-over factor.

Loads

Allows you to define new loads to be applied as member loads, or edit existing ones. A load 
entry consists of label, orientation, direction, type, intensity, and location.

Load Cases

Allows you to define the load cases under which the member loads, joint loads, and joint 
known displacements, will be defined. Each load case should have a unique label.
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3.7 Process Menu

Process menu contains commands that enable you to create the 
model geometry, assign the physical properties to its members and 
joints, and apply some refinement to the model.

Joints

Allows you to define new joints or edit existing ones by inputting 
their labels and coordinates. Joints can also be input by generating 
multiple copies of already defined joints while incrementing their 
coordinates.

Fixities

Allows you to define supports by fixing the degrees of freedom of 
some already defined joints.

Inclined Supports

Allows you to define inclined supports by inputting the angle of inclination of already defined 
fixed joints (supports).

Spring Supports

Allows you to define elastic supports (springs) by inputting rotational and/or translational 
stiffnesses at already defined joints.

Members

Allows you to define new members, or edit existing ones. A member is defined by assigning 
to it a label, a start joint, and an end joint. You can also specify the member to be considered as 
a tension-only member. Members can also be input by generating multiple copies of already 
defined members while incrementing their start and/or end joints.

Member Types

Allows you to assign material properties, section properties, a nonprismatic member 
definition, and an orientation angle to the defined members.

Partial Releases

Allows you to define hinged or partially fixed member ends by assigning moment release 
coefficients to already defined members.
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Shear Corrections

Allows you to assign section shape factors to already defined members to account for shear 
corrections in members such as shear walls and deep beams.

Rigid-end Offsets

Allows you to account for the finite width of a supporting member by inputting the half-width 
of the support that a member is framing into at either of its ends. If a member is specified to 
have a rigid-end offset, the portion of this member within the offset is considered to be 
infinitely stiff.

Rigid Diaphragms

Allows you to specify the horizontal members (beams) to be connected to a rigid diaphragm 
(slab) at any already input elevation (floor levels). Diaphragms are assumed to be infinitely 
stiff in the out-of-plane direction and flexible in the in-plane direction. Members attached to 
the same diaphragm will have the same horizontal displacement.

Member Group

Allows you to define member groups by inputting a member group label and selecting the 
members to be included in that group. The output results for each defined group represent the 
maximum values of each member in that group.

3.8 Analyze Menu

The Analyze menu contains commands that enable you to apply the 
defined loads to the members, input joint loads, combine load cases, 
solve the problem, and view the results. 

3.8.1 Member Loads

Allows you to apply the loads defined using the Define/Loads 
command to the defined members under defined load cases.

3.8.2 Joint Loads

Allows you to input joint loads by specifying the joint to be loaded, 
the load case under which the load should be included, and inputting 
the forces and/or moments acting at the joint.
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3.8.3 Known Displacements

Allows you to input prescribed joint displacements by specifying the load case under which this 
displacement should be included and inputting the translational and/or rotational displacements 
occurring at the joint.

3.8.4 Self Loads

Allows you to select the members whose self weight should be included in the predefined SELF 
load case.

3.8.5 Load Combinations

Allows you to factor the defined load cases and combine them into load combinations under which 
the structure will be analyzed.

3.8.6 Solve

Allows you to start the solution process. You can choose to optimize the model, specify the order 
of solution (first order or second order), and whether to save the matrices or not.

3.8.7 Joint Results

After a successful solution, this command allows you to view joint displacements, joint rotations, 
member end forces, and member end moments under any specified load combination.

3.8.8 Support Reactions

After a successful solution, this command allows you to view the fixed joints (supports) reactions 
under any specified load combination.

3.8.9 Member Results

After a successful solution, this command allows you to view graphically and in text format, the 
local results of any member under any load combination. Local results may include in-plane and 
out-of plane moment, shear, deflection, as well as torsion and axial force. You can also view a 
member summary. All viewed graphs and results may be printed.

3.8.10 Envelopes

After a successful solution, this command allows you to view graphically and in text format, the 
local results envelopes (maximum and minimum values for all load combinations) of any member. 
Envelope results include in-plane and out-of plane moment and shear, as well as torsion and axial 
force. All viewed graphs and results may be printed.
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3.8.11 Group Results

After a successful solution, this command allows you to view graphically and in tabular format, 
the local results envelopes (maximum and minimum values for all load combinations for all the 
members in a group) of any member group. Group results include in-plane and out-of plane 
moment and shear, as well as torsion and axial force. All viewed graphs and results may be 
printed.

3.9 Show Menu

The Show menu options and commands enable you to control and 
manipulate the graphical display of the structure as well as graphically 
display loads and global results. 

Zoom

Allows you to magnify or reduce the graphical image displayed in the 
Graphics area.

Rotate

Allows you to rotate the graphical image displayed in the Graphics 
area about the X-axis or the Y-axis. By combining the rotation about 
the two axes, you will be able to view the structure from any angle. 

Translate

Allows you to translate or move the graphical image displayed in the Graphics area.

Stereo

An option that toggles the Stereoscopic viewing mode On or Off.

Reset

An option that resets the graphical image to its original position, scale, and orientation.

Select

Allows you to select (tag) or deselect a portion of the structure to be made visible.

Hide/Show

An option that allows you to show or hide tagged members and joints.



OPERATING spFrame

| 56 |

Preferences

Allows you to specify what is to be displayed in the Graphics area. You may select from joint 
numbers, member numbers, fixities, and member orientation.

Load Diagrams

Allows you to view the input loads (point and distributed) superimposed on the model 
graphical image. You can also specify the magnification factor of the displayed loads.

Result Diagrams

After a successful solution, this command allows you to view the global results (deflected 
shape, moments, and shear) superimposed over the model graphical image. You can also 
specify the magnification factor of the displayed results.

Member Info

Displays a member information window over the spFrame window that allows you to get 
important information about the defined members.

3.10 Options Menu

The Options menu allows you to change the startup options of the spFrame program to suit your 
needs. These changes are saved in the Windows registry file and they become the default settings 
when spFrame is executed. 

Save Settings

Allows you to save the defaults and settings of the current file into the 
Windows registry file to be used in future input sessions

Color

Allows you to modify colors of the graphical image.

Autosave

An option that, if selected, causes the data to be saved periodically without selecting the Save 
command. You can also specify the Autosave time interval.
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3.11 Help Menu

The Help menu includes commands that enable you to obtain on-line 
help for the spFrame program. The help screens in the programs are 
closely related with Chapters 3 and 4 of this manual. 

Manual

Opens spFrame Manual in the default PDF viewer..

About spFrame

This command displays a message box that gives you copyright information, the version 
number of the spFrame program, your firm name, city, and state.

Check for Updates

Checks if a newer version of the program is available. Internet connection is required.

3.12 Creating New File

When spFrame is first loaded, it is ready to obtain input for a new file. The data will not have a 
filename associated with it, therefore, Untitled appears in the Title bar. 

From the File menu, select New. This clears the screen and returns to the default settings of the 
program. If existing data have been changed prior to executing the New command, spFrame asks 
if you want to save the data. At any time after starting a new file, use the Save As command to give 
the file a name.

3.13 Opening File

spFrame data files are stored as binary or text (ASCII) files.

• From the File menu, select Open. The dialog box of Figure 3-2 appears.

• From the LIST FILES OF TYPE drop-down list, select the type of file to be opened. 
spFrame files are saved in binary format with an FRM extension, while spFrame text files 
are saved in ASCII format with a TXT extension. All files with the selected extension 
contained in the current drive and directory are displayed in the FILE NAME list box.

• To open a file that exists in another drive or directory, select the drive or directory from the 
DRIVES drop-down list or the DIRECTORIES list box, respectively.
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Figure 3-2 Open dialog box

• From the FILE NAME list box, select the file to be opened, or simple type its name in the 
text box.

• Choose the OK button

3.14 Saving

In spFrame you can save the data in the spFrame format with the same filename or with a new 
filename. You can also save the data in a different format

3.14.1 Saving your data with the same filename

If you are editing a data file that has previously been saved under a filename, select the Save 
command from the File menu to save the changes under that same filename. Selecting the Save 
command before giving the file a name causes the SAVE AS dialog box to appear

3.14.2 Giving your data a different filename

• From the File menu, select Save As. The dialog box of Figure 3-3 appears. 
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Figure 3-3 Save As dialog box

• From the SAVE FILE AS TYPE drop-down list, select spFRAME FILES. All files with 
an FRM extension contained in the current drive and directory are displayed in the FILE 
NAME list box.

• To save the file to a drive or directory other than the default, select a different drive from 
the DRIVES drop-down list or a different directory from the DIRECTORIES list box.

• In the FILE NAME text box, type a new filename. You do not have to specify a file 
extension, .FRM will be appended to the specified filename.

• Choose the OK button.

3.14.3 Saving data in a different format

spFRAME allows you to save you data in a format other than its own. ASCII (or text) is the only 
other format that has been implemented. The advantage of saving data in text format is that you 
will be able to edit or view the input data file using any text editor or word processor.

If you edit a spFrame text file using an editor or a word processor, it is your responsibility to 
maintain the data structure and format. Make sure that you save the file as a pure ASCII file (or 
nondocument format) otherwise, spFrame will not be able to open it again. We advise that you 
save a copy of the file in binary (FRM) format before you save it in text (TXT) format. This way 
you will have a backup of your work if something goes wrong in the TXT data file.

Note: Only input data information is included in files saved in text format. No output data or 
graphics information are saved.

• From the File menu, select Save As. The dialog box of Figure 3-3 appears.
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• From the SAVE FILE AS TYPE drop-down list, select spFRAME ASCII. All files with a 
TXT extension contained in the current drive and directory and are displayed in the FILE 
NAME list box.

• To save the file to a drive or directory other than the default, select a different drive from 
the DRIVES drop-down list or a different directory from the DIRECTORIES list box.

• In the FILE NAME text box, type a new filename.

• Choose the OK button.

3.15 Importing File

If you create the model geometry using AutoCAD (Release 9 or later), you will be able to import 
those files into spFrame using the File/Import command. Imported files must be saved in the DXF 
format. The drawing should be generated in AutoCAD in the 3-D mode using 3-D lines, with the 
DXFOUT option selected. Also note that the Z and Y axes are switched in AutoCAD.

• From the File menu, select Import. The dialog box of Figure 3-4 appears.

• From the LIST OF FILES OF TYPE drop down list, select DXF FILES. All files with a 
DXF extension contained in the current drive and directory are displayed in the FILE 
NAME list box.

• To open a file that exists in another drive or directory, select the drive or directory from the 
DRIVES drop-down list or the DIRECTORIES list box, respectively.

• From the FILE NAME list box, select the file to be opened, or type its name in the text 
box.

• Choose the OK button.
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Figure 3-4 Import dialog box

3.16 Export File

The model geometry created in spFrame can be exported to AutoCAD (Release 9 or later) using 
the File/Export command. You may have to scale or zoom the drawing in AutoCAD to view it at 
a suitable scale.

• From the File menu, select Export. The dialog box of Figure 3-5 appears.

• From the SAVE FILE AS TYPE drop-down list, select DXF FILE. All files with a DXF 
extension contained in the current drive and directory are displayed in the FILE NAME 
list box.

• To save the file to a drive or directory other than the default, select a different drive from 
the DRIVES drop-down list or a different directory from the DIRECTORIES list box.

• In the FILE NAME text box, type a new filename.

• Choose the OK button.
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Figure 3-5 Export dialog box

3.17 Printing Results

After performing a successful run, you may view or print individual member and group results in 
text or graphical format using the Joint Results, Support Reactions, Member Results, 
Envelopes, and Group Results commands from the Analyze menu. You may also superimpose 
results diagrams on the model image using the Results Diagrams command from the Show menu. 
To print comprehensive text results and input echo, use the File/Print Results command. Your 
selection of printout can be applied to all or selected members, joints, load combinations, and 
member groups.

• From the File menu, select Print Results. The dialog box of Figure 3-6 appears.

• To print an input echo, select the check-box options in the INPUT ECHO options group. 
You can select to print DEFINITIONS (all data input through the Define menu 
commands), GEOMETRY (joints and members data and their assignments and 
definitions), and LOADS (applied member and joint loads and load combinations).A 

selected option contains an  in its check box.✓
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Figure 3-6 Print Results dialog box

• To print the messages generated during the solution process, select the SOLVER 
MESSAGES check-box option.

• In the RESULTS options group, select the output options to be printed. A selected option 
contains an X in its check box. You can print the applicable options from the various 
Results options. These include joint displacements, joint rotations, support reactions, 
member end forces, member end moments, diaphragm displacements, member summary, 
segmental values, envelope results, and group results.

• In the SELECTION options group, specify whether the results printing applies to all or 
selected joints, members, load combinations, or member groups.

3.17.1 Printing results for all joints

• Select the check box next to the JOINTS button.

3.17.2 Printing results for selected joints only

• Clear the check box next to the JOINTS button.

• Choose the JOINTS button. The dialog box of Figure 3-7 appears.
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Figure 3-7 Joint Select dialog box

• From the JOINT LIST list box, select the joint whose results you want to print.

• Choose the ADD button. The selected joints are added to the SELECTED LIST list box on 
the right.

• Repeat the two steps above until all the joints whose results you want to be printed are in 
the SELECTED LIST list box.

• To remove a joint that has already been added to the list box, select that joint from the list 
box and choose the REMOVE button.

• Choose the OK button

The selection procedure described for joints above applies to members, load combinations, and 
member groups.

• Choose the PRINT button.

• A message box appears informing you that the output is being sent to the active printer. 
Choose the CANCEL button to terminate the print job.

3.18 Printing Screen

You may obtain a printed image of whatever is displayed in the Graphics area of the spFrame 
window by using the File/Print Screen command. The graphical printout is a copy of the image 
displayed in the Graphics area of the window with whatever settings are selected such as joint 
numbers, member numbers, fixities, orientation, superimposed diagrams, etc.

• From the File menu, select Print Screen.

• A message box appears informing you that the image is being sent to the active printer. 
Choose the CANCEL button to terminate the print job.
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3.19 Auto Input

spFrame has an automatic input feature that walks you through the input process in a logical order. 
Selecting the Access/Auto Input command opens the necessary dialog boxes to complete the 
input of a problem.

• From the Access menu, select Auto Input.

• The TYPE dialog box is the first to appear in an input session.

• Complete the input fields in this box and choose the OK button.

• Consequently, other dialog boxes appear in the order they are displayed in the Define, 
Process, and Analyze menus. Complete the input needed in each dialog box and choose 
the OK button.

• To abort auto input, choose the CANCEL button in any active dialog box.

3.20 Working with Libraries

Defined material properties, sections, non-prismatic member entries, and loads can be saved in 
library files to be accessed by other files. Saving entries into libraries and retrieving entries from 
libraries can be done using the Access/Library command. 

• From the Access menu, choose Library. The dialog box of Figure 3-8 appears.

• You can create a new library, open an existing library, read library definitions into your 
current file, save definitions from your file into a library, or delete definitions from a 
library. These procedures are explained below. Note that you can perform more than one 
procedure in one session. For example, you can read definitions from your file to a library, 
read other definitions from the same library to your file, and delete some definitions from 
the library without having to close the dialog box after every operation.

• Choose DONE to close the dialog box.
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Figure 3-8 Library dialog box

3.20.1 Creating a New Library File

• From the TYPES drop down list, select a library type. You may choose from materials, 
sections, nonprismatic, and loads.

• In the FILE NAME text box, enter a filename (.FTM, .FTS, .FTN, or .FTL extension will 
be appended to it).

• In the DESCRIPTION text box, enter a brief library descriptive label.

• To save the library file to a drive or directory other than the default, select a different drive 
or directory from the PATH list box.

• Choose the SAVE button.

3.20.2 Opening a Library File

• From the TYPES drop down list, select a library type. You can choose from materials, 
sections, nonprismatic, and loads. The library files of the type selected are displayed in the 
FILES list box and the definitions of the selected type that are contained in the file are 
displayed in the INCLUDED ITEMS list box.

• From the FILES list box, select the library file to be opened, or type its name in the FILE 
NAME text box. To open a library file that exists in another drive or directory, select the 
drive or directory from the PATH list box.

• Choose the OPEN button. This opens the selected library file and displays its definitions 
in the LIBRARY ITEMS list box.

3.20.3 Saving Items from an Open Data File to a Library

• Open a library file.

• From the INCLUDED ITEMS list box, select the definitions to be saved.
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• Choose the "<-" button. The selected definitions are added to the LIBRARY ITEMS list 
box.

• Choose the SAVE button.

3.20.4 Reading Items from a Library to an Open Data File

• Open a library file.

• From the LIBRARY ITEMS list box, select the definition you want.

• Choose the "->" button. The selected definitions are added to the INCLUDED ITEMS list 
box.

3.20.5 Deleting a Library Item

• Open a library file.

• From the LIBRARY ITEMS lit box, select the definitions to be deleted.

• Choose the DEL button. The selected definitions are removed from the LIBRARY ITEMS 
list box.

• Choose the SAVE button.

3.21 Copying Graphics to the Clipboard

In spFrame, you can copy a portion of the graphic image displayed in the Graphics area to the 
Window’s clipboard. This image can then be pasted into any other Windows application using its 
Paste command (usually located in the application’s Edit menu).

• From the Access menu, select Copy.

• Within the Graphics area, using the left-mouse button, marquee select the portion of the 
image you want to copy.

• You may view the copied information by opening the Clipboard Viewer, located in the 
Main program group of the Windows Program Manager.

3.22 Defining Settings

• From the Access menu, select Settings. The dialog box of Figure 3-9 appears.

• Enter the distance from viewer to monitor screen and half the distance between viewer’s 
eyes (in pixels) in the corresponding text boxes. Default values are 3000 and 50, 
respectively.
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Figure 3-9 Settings dialog box

• Choose the far and near line colors whether red and blue, respectively, or blue and red, 
respectively.

• Enter the DXF data import accuracy in the corresponding text box. This value is the range 
within which two joints will be considered as one when encountered in a DXF file. Units 
are length units.

• Choose the OK button.

3.23 Define Structure Type

• From the Define menu, select Type. The dialog box of Figure 3-10 appears.

• From the STRUCTURE TYPE options group, select a structure type. Options include 2-D 
frames, 3-D frames, 2-D trusses, or 3-D trusses. The availability of other commands and 
options depends on the type of structure selected.

• Enter the project and engineer labels in the corresponding text boxes. These labels help 
organize and identify data files.

Figure 3-10 Type dialog box

• Choose the OK button.
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3.24 Define Units

• From the Define menu, select Units. The dialog box of Figure 3-11 appears.

• Select a system of units to be used, ENGLISH or METRIC.

• To change the units of an input or output parameter, open the list box associated with that 
parameter and select the appropriate units from the drop-down list.

• Choose the OK button.

3.25 Define Defaults

Every member must have a defined material, section properties, and an orientation angle. 
However, if for some reason a member was not assigned any properties, spFrame assigns default 
values to that member. You can set or change these defaults to suit the most common members in 
the structure.

• From the Define menu, select Defaults. The dialog box of Figure 3-12 appears. Some text 
boxes may not be available, depending on the structure type selected. In the corresponding 
text boxes, enter the values of modulus of elasticity (E), material density (d), member 
cross-section area (A), section moment of inertia about the local z-axis (Iz), section 
moment of inertia about the local y-axis (Iy), section polar moment of inertia (J), material 
Poisson’s ratio (v), material thermal coefficient (a), and member orientation angle (b).

• Choose the OK button.

Figure 3-11 Units dialog box

The values entered here are assigned to a DEFAULT material, a DEFAULT section, and a 
DEFAULT orientation angle. They may be saved in the Windows Registry file using the Options/
Save Settings command and will be read in future input sessions
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Figure 3-12 Defaults dialog box

3.26 Define Materials

Material properties are first defined using the Define/Materials command and then assigned to 
the different members using the Process/Member Types command.

• From the Define menu, select Materials. The dialog box of Figure 3-13 appears.

• Enter a material label in the LABEL text box.

• Enter the material density (d), modulus of elasticity (E), Poisson’s ratio (v), and thermal 
coefficient (a), in the corresponding text boxes.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.

• Repeat the three steps above for each material entry you have, making sure that no 
duplicate labels are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values in the text boxes, and choose the MODIFY button.
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Figure 3-13 Materials dialog box

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.27 Define Sections

Cross-section properties of all members are defined using the Define/Sections command and then 
assigned to the different members using the Process/Member Types command.

• From the Define menu, select Sections. The dialog box of Figure 3-14 appears.

Figure 3-14 Sections dialog box
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• Open the TYPE list box and select a section type from the drop-down list. Available 
sections are user defined, rectangular, circular, T-section, and L-section. The remaining 
text boxes change depending on the section type selected.

• Enter a section label in the LABEL text box.

• For a USER DEFINED section, enter the area, moment of inertia about the local z axis 
(Iz), moment of inertia about the local y axis (Iy) and the polar moment of inertia of the 
section (J), in the corresponding text boxes.

• For a RECTANGULAR section, enter the width (along the local z axis) and depth (along 
the local y axis) of the section in the corresponding text boxes.

• For a CIRCULAR section, enter the diameter of the section in the corresponding text box.

• For an L-SECTION section, enter the flange width, flange thickness, web width, and web 
thickness in the corresponding text boxes.

• For a T-SECTION section, enter the flange width, flange thickness, web width, and web 
thickness in the corresponding text boxes.

• For any type section you select, input the cracked section coefficients in the CRACK 
COEFFICIENT group text boxes. You can input coefficients that will be multiplied by the 
area, moment of inertia Iz, moment of inertia Iy, and polar moment of inertia, J. The 
values entered must be between 0 and 1.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom. Note that the cracked section coefficients will not be shown in the list box, 
however, their values are saved by the program.

• Repeat the steps above for each section entry you have, making sure that no duplicate 
labels are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values in the text boxes, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.28 Define Nonprismatic Members

Nonprismatic members are first defined using the Define/Nonprismatic Members command and 
then assigned to the different members using the Process/Member Types command. Non-
prismatic members can be defined for frame structures only.
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• From the Define menu, select Nonprismatic Members. The dialog box of Figure 3-15 
appears.

• Enter a non-prismatic member label in the LABEL text box.

• Enter the in-plane stiffness factors at the start joint (J1) and the end joint (J2), Kii and Kjj 
respectively, and the carry-over factor, Kij, in the corresponding text boxes under IN-
PLANE ABOUT Z.

• Enter the out-of-plane stiffness factors at the start joint (J1) and the end joint (J2), Kii and 
Kjj respectively, and the carry-over factor, Kij, in the corresponding text boxes under 
OUT-OF-PLANE ABOUT Y.

Figure 3-15 Nonprismatic Members dialog box

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.

• Repeat the four steps above for each non-prismatic member entry you have, making sure 
that no duplicate labels are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values in the text boxes, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.29 Define Loads

Loads can be applied to joints and members or input as joint known displacements. The loads 
defined using the Define/Loads command can be applied to members only. They can be assigned 
to the different members using the Analyze/Member Loads command. Joint loads are input using 
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the Analyze/Joint Loads command and joint known displacements are input using the Analyze/
Known Displacements command.

• From the Define menu, select Loads. The dialog box Figure 3-16 appears.

Figure 3-16 Loads dialog box

• Enter a load label in the LABEL text box.

• From the TYPE options group, choose a load type. Loads can be point (concentrated), 
uniform, left triangle, right triangle, moment (concentrated), or temperature. The 
remaining text boxes change depending on the load type selected.

• From the ORIENTATION options group, choose a load orientation. Load orientation can 
be local, global, or projection.

• From the DIRECTION options group, choose a load direction. The direction chosen is 
related to the orientation and can be X, Y, or Z.

• For a POINT load, enter the load intensity and the ratio of load location from member start 
joint (J1) to the member length, in the corresponding text boxes.

• For a UNIFORM load, enter the load intensity, the ratio of load start location from the 
member start joint (J1) to the member length, and the ratio of load length to member 
length, in the corresponding text boxes.

• For a RIGHT TRIANGLE load, enter the load intensity at the left, the ratio of load start 
location from the member start joint (J1) to the member length, and the ratio of load length 
to member length, in the corresponding text boxes.

• For a LEFT TRIANGLE load, enter the load intensity at the right, the ratio of load start 
location from the member start joint (J1) to the member length, and the ratio of load length 
to member length, in the corresponding text boxes.
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• For a MOMENT load, enter the load intensity and the ratio of load location from the 
member start joint (J1) to the member length, in the corresponding text boxes.

• For a TEMPERATURE load, enter the distance between the two surfaces subject to 
temperature change in the MEMBER THICKNESS text box and the temperature change 
at the top and bottom of the member, in the corresponding text boxes.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.

• Repeat the steps above for each load entry you have, making sure that no duplicate labels 
are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values in the text boxes, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.30 Define Load Cases

Every applied load, whether a member load, joint load, or known displacement, must belong to a 
load case. Load cases are defined using the Define/Load Cases command. Loads are assigned to 
members and joints under the defined load cases, and the load cases are then factored and 
combined.

• From the Define menu, select Load Cases. The dialog box of Figure 3-17 appears. Note 
that the SELF load case is already added to the list box.

• In the LABEL text box, enter a load case label.

Figure 3-17 Load Cases dialog box

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
right.
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• Repeat the two steps above for each load case entry you have, making sure that no 
duplicate labels are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its label in the text box, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.31 Define Joints

The first step in defining the structure geometry is inputting the joints. Joint coordinates are 
defined using the Process/Joints command.

• From the Process menu, select Joints. The dialog box of Figure 3-18 appears. Some text 
boxes may not be available, depending on the structure type selected. 

Figure 3-18 Joints dialog box

• In the LABEL text box, enter a joint label.

• Enter the joint X, Y, and Z coordinates in the corresponding text boxes. Joint coordinates 
are referenced in the global coordinate system.

• Select or clear the SHOW TAG check box. If this option is clear, the joint will be shown or 
hidden when you toggle the Hide/Show command ON or OFF, respectively. If this option 
is selected (i.e., the joint is tagged), the joint will always be shown regardless of the Hide/
Show status.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.
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• Repeat the four steps above for each joint entry you have, making sure that no duplicate 
labels are entered.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values in the text boxes, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.31.1 Generating Joints

Joints can also be generated by duplicating an already defined joint (or a group of joints) a number 
of times, while incrementing its (or their) coordinates.

• In the JOINTS dialog box, choose the GENERATE button (this command button will be 
dimmed if no joints are input). The dialog box of Figure 3-19 appears. Some text boxes 
may not be available, depending on the structure type selected.

Figure 3-19 Joint Generation dialog box

• In the FROM JOINT text box, enter the label of the first joint to be copied.

• In the TO JOINT text box, enter the label of the last joint to be copied. If the last joint 
label is the same as the first joint label, only that joint will be affected by the copying 
process.

• In the QUANTITY text box, enter the number of copies to be generated.

• In the DELTA X, DELTA Y, and DELTA Z text boxes, enter the increment to be added to 
the X, Y, and Z coordinates, respectively.

• Choose the OK button. The generated joints are added to the list box of the JOINTS dialog 
box.
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3.32 Define Fixities

All defined joints are assumed to be free to move or rotate in the direction related to their degrees 
of freedom. Fixed joints (supports) are defined using the Process/Fixities command.

• From the Process menu, select Fixities. The dialog box of Figure 3-20 appears. Some 
options may not be available depending on the structure type selected.

Figure 3-20 Fixities dialog box

• From the JOINT LIST list box, select the joint whose fixities you want to specify.

• In the FIXITIES options group, select the joint displacement or rotation to be fixed.

An  in a check box denotes that the displacement or rotation associated with that box is fixed. A 
clear box denotes that the displacement or rotation associated with that box is free.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.

• Repeat the three steps above for each fixed joint entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

✓
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3.33 Define Inclined Supports

All defined supports (fixed joints) are assumed to be horizontal or vertical (parallel to one of the 
global axes). There are cases however, when a support is inclined. Such supports are defined using 
the Process/Inclined Supports command.

• From the Process menu, select Inclined Supports. The dialog box of Figure 3-21 
appears. Some options may not be available, depending on the structure type selected.

• From the FIXED JOINTS list box, select the fixed joint to be specified as an inclined 
support. 

• Enter the inclination angle measured clockwise between the global coordinate axis and the 
rotated axis, in degrees. For two-dimensional structures, enter the X-axis rotation in the 
ANGLEX text box. For three-dimensional structures, enter the X-axis and the Z-axis 
rotations in the ANGLE X and ANGLE Z text boxes, respectively.

Figure 3-21 Inclined Supports dialog box

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the three steps above for each inclined support entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.
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3.34 Define Spring Supports

You can define elastic supports (springs) using the Process/Springs Supports command. You can 
specify translational (linear) springs for truss structures, and both translational and rotational 
springs for frame structures.

• From the Process menu, select Spring Supports. The dialog box of Figure 3-22 appears. 
Some text boxes may not be available, depending on the structure type selected.

• From the JOINT LIST list box, select the joint that you want as a spring support.

• For frame structures, enter the translational and rotational spring constants for the active 
degrees of freedom (Kx, Ky, Kz, KRx, KRy, KRz) in the corresponding text boxes.

Figure 3-22 Spring Supports dialog box

• For truss structures, enter the translational spring constants for the active degrees of 
freedom (Kx, Ky, Kz) in the corresponding text boxes.

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the steps above for each spring support entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.
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3.35 Define Members

After defining the joints, you will be able to define the members using the Process/ Members 
command.

• From the Process menu, select Members. The dialog box Figure 3-23 appears. 

Figure 3-23 Members dialog box

• In the LABEL text box, enter a member label.

• Enter the start joint of the member by either typing its label in the START J1 text box, or 
by selecting it from the START J1 list box.

• Enter the end joint of the member by either typing its label in the END J2 text box, or by 
selecting it from the END J2 list box.

• If the member is to be considered a tension-only member, select the TENSION 
ELEMENT check-box option.

• Select or clear the SHOW TAG option. If the option is clear, the member will be shown or 
hidden when you toggle the Hide/Show command ON or OFF, respectively. If the option 
is selected (i.e., the member is tagged), the member will always be shown regardless of the 
Hide/Show status.

• Choose the ADD button or press ENTER. The data entered are added to the list box at the 
bottom.

• Repeat the steps above for each member entry you have, making sure that no duplicate 
labels are entered.

• To edit an entry that has already been added to the list box, select that entry from the list 
box, modify its values in the text boxes, and choose the MODIFY button.
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• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose OK when done.

3.35.1 Generating Members

Members can be generated by duplicating an already defined member or a group of members, a 
number of times, while incrementing its or their start and end joints.

• In the MEMBERS dialog box, choose the GENERATE button (this command button will 
be dimmed if no members are input). The dialog box of Figure 3-24 appears.

• In the FROM MEMBER text box, enter the label of the first member to be copied.

• In the TO MEMBER text box, enter the label of the last member to be copied. If the last 
member label is the same as the first member label, only that member will be affected by 
the copying process.

Figure 3-24 Member Generation dialog box

• Enter the increment to be added to the start joint and end joint of each specified member, 
in the DELTA J1 and DELTA J2 text boxes, respectively.

• In the QUANTITY text box, enter the number of copies to be generated.

• Choose the OK button. The generated members are added to the list box of the 
MEMBERS dialog box.

3.36 Assign Member Types

Material, section, non-prismatic member, and orientation angle member assignments are globally 
defined using the values entered in the DEFINE/DEFAULTS dialog box. Members that do not 
have DEFAULT material, DEFAULT section, DEFAULT nonprismatic member, and DEFAULT 
orientation angle assignments can be assigned their properties using the Process/Member Types 
command.
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• From the Process menu, select Member Types. The dialog box Figure 3-25 appears. 
Some options may not be available, depending on the structure type selected.

• From each of the MATERIAL TYPE, SECTION TYPE, and NONPRISMATIC 
MEMBER dropdown list boxes, select a material type, section type, and nonprismatic 
member to be assigned.

• In the ORIENTATION ANGLE text box, enter the member orientation angle (in degrees) 
if other than zero.

• From the MEMBER LIST list box, select the member to assign the selected properties for.

• Choose the ADD button. The selected member is added to the list box at the bottom.

• Repeat the four steps above for each member type entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

Figure 3-25 Member Types dialog box

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.37 Define Partial Releases

All frame members are assumed to have full fixity at their ends. To define hinged or partially fixed 
member ends, use the Process/Partial Releases command. This command is available for frame 
structures only.

• From the Process menu, select Partial Releases. The dialog box of Figure 3-26 appears. 
Some options may not be available depending on the structure type selected. 
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• From the MEMBER LIST list box, select the member to specify partial releases at its 
ends.

Figure 3-26 Partial Releases dialog box

• In the corresponding text boxes, enter the partial release factors at the member start and 
end joints, Vi and Vj respectively, about the local z axis and, for 3-D frame structures only, 
about the local y axis. The values input must be between 0 and 100, where 0 represents a 
fixed end, 100 represents a hinged end, and any value in between represents the amount of 
moment to be released.

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the three steps above for each partial release entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.38 Define Shear Corrections

By default, shear deformations are not included in computing a member deformation. To include 
shear deformations for a member, use the Process/Shear Corrections command. This command 
is available for frame members only.

• From the Process menu, select Shear Corrections. The dialog box of Figure 3-27 
appears.
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Figure 3-27 Shear Corrections dialog box

• From the MEMBER LIST list box, select the member to input a shape factor for.

• In the SHAPE FACTOR text box, enter the shape factor. The value entered must be 
between 0.1 and 10.

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the three steps above for each shear correction entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its value, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.39 Define Rigid-end Offsets

By default, the member length used in stiffness computations is the start joint-to-end joint length 
(center-to-center length). To account for the finite-support width and force the program to use the 
clear member length, use the Process/Rigid-end Offsets command to assign a half-support width 
at a member end. The member is assumed to be rigid within that width. This command is available 
for frame structures only.

• From the Process menu, select Rigid-end Offsets. The dialog box Figure 3-28 appears.

• From the MEMBER LIST list box, select the member to input rigid-end offsets for.

• Enter the support half width at the member start joint and end joint, Di and Dj, 
respectively, in the corresponding text boxes.
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• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the three steps above for each rigid-end offset entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

Figure 3-28 Rigid-end Offsets dialog box

3.40 Define Rigid Diaphragms

Use the Process/Rigid Diaphragms command to assign a rigid diaphragm (slab) to all or selected 
horizontal members (beams) sharing the same elevation (Y coordinate). The rigid diaphragm is 
assumed to be infinitely stiff in its own plane (XZ plane). This command is available for frame 
structures only.

• From the Process menu, select Rigid Diaphragms. The dialog box of Figure 3-29 
appears. spFrame automatically sorts the already defined members and groups all 
horizontal members that have the same Y coordinate into defined elevations. These 
elevations are shown in the ELEVATION drop-down list.

• From the ELEVATION drop-down list, select the elevation (level) at which you want to 
specify a rigid diaphragm (slab). The horizontal members belonging to that level are 
shown in the MEMBER LIST list box below it.
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• To attach a horizontal member to a rigid diaphragm at the selected elevation, select that 
member from the MEMBER LIST list box, and choose the ADD button. The member is 
added to the SELECTED MEMBERS list box.

• To remove a horizontal member that has already been attached to a diaphragm from that 
diaphragm, select the member from the MEMBER LIST list box, and choose the 
DELETE button. The member is removed from the SELECTED MEMBERS list box.

Figure 3-29 Rigid Diaphragm dialog box

• To attach all the horizontal members at the selected elevation to a rigid diaphragm, choose 
the INCLUDE ALL button. The members appear in the SELECTED MEMBERS list box.

• To remove all horizontal members that have already been attached to a diaphragm from 
that diaphragm, choose the REMOVE ALL button. The members are removed from the 
SELECTED MEMBERS list box.

• Choose the OK button.

3.41 Define Member Groups

The analysis results under the different load combinations are output, along with the results 
envelopes, for each defined member. Using the Process/Member Group command, you can 
group several members together and get the maximum and minimum results of all these members 
under all loading combinations. Typical member groups can be columns of the same tributary area 
at the same level or beams of equal spans and loading. Envelope results provide you with a 
summary of member results to be used in designing the members of the same group.

• From the Process menu, select Member Group. The dialog box of Figure 3-30 appears.
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Figure 3-30 Member Group dialog box

• In the LABEL text box, enter a group label.

• Select or clear the CONFIRM LENGTH check box. If this option is selected, the program 
checks all selected members to make sure that they have the same length. If you clear this 
option, be very careful in selecting the grouped members. If you select members of 
different length to be in one group, the group results can be misleading since the output 
results will not be compared at the same location along a member length.

• From the MEMBER LIST list box, select the member that you want to add to the group. 

• Choose the INCLUDE button. The member is added to the SELECTED MEMBERS list 
box. Note that if you select members with different lengths and the CONFIRM LENGTH 
option is ON, only the members with the same length as the first selected member are 
added.

• Repeat the steps above until all members that you want to group are in the SELECTED 
MEMBERS list box. If you added a member to the SELECTED MEMBERS list box by 
mistake, delete that member by selecting it in the list box and choose the REMOVE 
button.

• Choose the ADD button. The group just defined is added to the list box at the bottom.

• Repeat the steps above for each group that you have.

• To edit a group that has already been added to the list box, select that group from the list 
box, edit its label or selected members, and choose the MODIFY button.

• To remove a group that has already been added to the list box, select that group from the 
list box and choose the DELETE button.

• 02Choose the OK button.
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3.42 Apply Member Loads

The loads defined using the Define/Loads command can be assigned to the members using the 
Analyze/Member Loads command. This command will be available after members, loads, and 
load cases are defined.

• From the Analyze menu, select Member Loads. The dialog box of Figure 3-31 appears.

Figure 3-31 Member Loads dialog box

• From the LOAD CASE drop-down list, select a load case under which the loads are to be 
applied to the members.

• From the LOAD LIST list box,

•  select the load to be applied.

• Choose the INCLUDE button. The load is added to the SELECTED LOADS list box.

• You can apply more than one load on a member, and a load can be applied more than once 
on a member. To do so, repeat the two steps above until all the loads are in the 
SELECTED LOADS list box. If you added a load to the SELECTED LOADS list box by 
mistake, delete that load by selecting it in the list box and choose the REMOVE button.

• From the MEMBER LIST list box, select the member that you want to apply the load(s) 
to.

• Choose the ADD button. The member appears in the LOADED MEMBERS list box.

• Repeat the five steps above for each member load entry you have. To define member loads 
under another load case, repeat the six steps above.
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• To edit a member load assignment that has already been added to the LOADED 
MEMBERS list box, select that member from the list box, edit its assignment, and choose 
the MODIFY button.

• To remove a member load assignment that has already been added to the LOADED 
MEMBERS list box, select that member from the list box and choose the DELETE button.

• Choose the OK button.

3.43 Apply Joint Loads

Applied joint loads (forces and moments) can be assigned to the defined joints using the Analyze/
Joint Loads command. This command will be available after joints and load cases are defined.

• From the Analyze menu, select Joint Loads. The dialog box of Figure 3-32 appears. 
Some text boxes may not be available depending on the structure type selected.

• From the LOAD CASE drop-down list, select a load case under which the joint loads 
should be considered.

• In the FX, FY, FZ, MX, MY, and MZ text boxes, enter the applicable forces and moments 
(referenced in the global coordinate system).

• From the JOINT LIST list box, select the joint at which to apply the load(s).

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the three steps above for each joint-load entry you have. To input joint loads under 
another load case, repeat the four steps above.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

Figure 3-32 Joint Loads dialog box
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• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.

3.44 Apply Known Displacements

Prescribed joint displacements, such as support settlements, incorrect tolerances, etc., can be 
defined using the Analyze/Known Displacements command. This command will be available 
after joints and load cases are defined. 

• From the Analyze menu, select Known Displacements. The dialog box of Figure 3-33 
appears. Some text boxes may not be available depending on the structure type selected.

Figure 3-33 Known Displacements dialog box

• From the LOAD CASE drop-down list, select a load case under which the known 
displacements should be considered.

• In the DX, DY, DZ, RX, RY, and RZ text boxes, enter the applicable joint displacements 
and rotations (referenced in the global coordinate system).

• From the JOINT LIST list box, select the joint at which the displacements and rotations 
occur.

• Choose the ADD button. The data entered are added to the list box at the bottom.

• Repeat the steps above for each joint known displacement entry you have.

• To edit an entry that has been added to the list box, select that entry from the list box, 
modify its values, and choose the MODIFY button.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.
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• Choose the OK button.

3.45 Include Self Loads

By default, member self weight is not included in the applied loads. However, you may include the 
self weight of all or just selected members using the Assign/Self Loads command. The member 
self weight is automatically computed and included in the SELF load case.

• From the Assign menu, choose Self Loads. The dialog box of Figure 3-34 appears

Figure 3-34 Self Loads dialog box

• From the MEMBER LIST list box, select the member whose self weight the program 
should calculate and include in the analysis.

• Choose the ADD button. The selected member is added to the list box at the bottom.

The list box also shows the intensity (force per unit length) of each selected member. Intensity is 
equal to the cross-sectional area of the member times its material density.

• To include all members, select the SELECT ALL check box option. All members are 
added to the list box at the bottom.

• To remove an entry that has already been added to the list box, select that entry from the 
list box and choose the DELETE button.

• Choose the OK button.
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3.46 Define Load Combinations

The defined load cases can be factored and combined under different combinations using the 
Analyze/Load Combinations command. You do not have to define the load combinations before 
you instruct the program to start solving the problem. However, the local processing will be 
performed and the final results will be presented for the defined load combinations only.

• From the Analyze menu, select Load Combinations. The dialog box of Figure 3-35 
appears.

3.46.1 To Add a Load Combination

• In the LABEL text box, enter a load combination label.

• From the LOAD CASE list box, select a load case to be factored and included in the 
combination.

• Enter a load factor in the FACTOR text box. The selected load case(s) will be multiplied 
by this factor.

• Choose the INCLUDE button. The resulting factored load case is added to the 
FACTORED CASES list box.

• Repeat the three steps above until you define all the factored load cases to be included in 
the combination.

• Choose the ADD button. The new load combination and the number of cases included in it 
are added to the list box at the bottom.

Figure 3-35 Load Combinations dialog box
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3.46.2 To Modify a Load Combination

• From the list box at the bottom, select the load combination to be modified. The 
corresponding factored cases are displayed in the FACTORED CASES list box.

• To change the load combination label, edit it in the LABEL text box.

• To change a defined factored load case, select it from the FACTORED CASES list box, 
edit the load factor in the FACTOR text box, and choose the INCLUDE button.

• To delete a defined factored load case, select it from the FACTORED CASES list box and 
choose the REMOVE button.

• Choose the MODIFY button.

3.46.3 To Delete a Load Combination

• From the list box at the bottom, select the load combination to be deleted.

• Choose the DELETE button. The load combination is removed from the list box.

• Choose the OK button when done.

3.47 Solve Model

After inputting the model geometry and defining the loads, the solution process can be started. 
From the Analyze menu, select Solve. The dialog box of Figure 3-36 appears. In the dialog box 
you may choose between several options.

Figure 3-36 Solve Options dialog box

3.47.1 Stiffness Matrix

Selecting this option instructs the solver to calculate the member stiffness matrices as well as the 
global stiffness matrix of the entire structure. This option must be selected if solving the problem 
for the first time or if, after solving the problem, joints, members, or their assignments and 



OPERATING spFrame

| 95 |

definitions have been edited. However, if, after solving the problem, loads or load combinations 
are changed, the option need not be selected since the stiffness matrix will not be affected by the 
changes.

3.47.2 Forces and Displacements

This option instructs the solver to calculate the load and displacement matrices. Joint 
displacements and reactions, along with the member end forces, will be computed as well.

3.47.3 Save Matrices

This option instructs the program to save the matrices on disk. spFrame keeps all input data and 
solution results in memory (if possible) for fast execution and presentation. The size of a data file 
containing the stiffness matrices can be very large. You have to make sure that you have enough 
room on your disk to store it.

If the geometry, joint, member properties, and definitions of the model do not change, and the 
matrices were saved at run time, you can solve the structure at a future time, under a different set 
of loads or load combinations, by selecting the FORCES & DISPLACEMENTS option. This 
reduces the amount of time needed to solve the problem significantly.

3.47.4 Solution

FIRST ORDER option is the only available choice when executing the solver for the first time for 
a particular problem. Second order calculations require certain values from the first order solution. 
Therefore, to include the P-Δ effects or solve for tension members, the problem must be solved 
with the FIRST ORDER option first, then solved again with the SECOND ORDER option.

• In the SECOND ORDER option, P-Δ EFFECTS and/or TENSION MEMBERS option 
may be selected.

3.47.5 Optimize

• To optimize the solution and minimize the bandwidth, choose the OPTIMIZE button. The 
dialog of Figure 3-37 appears.

• Select the AUTOMATIC option to let the program calculate the starting joint for 
optimization.
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Figure 3-37 Optimize Bandwidth dialog box

• Clear the AUTOMATIC option to input an optimization starting joint in the corresponding 
text box.

• Choose the START button to start the optimization process. The resulting bandwidth is 
displayed.

• Choose the OK button to accept the optimization, or CANCEL otherwise.

Note that joint renumbering due to optimization is internal and does not affect the defined joint 
labels.

3.47.6 Solve

• After selecting the solver options, choose SOLVE. The spFrame program minimizes to an 
icon and the spFrame Solver window (shown in Figure 3-38) is displayed. The status box 
displays messages about the solution process and its progress. Should any errors or 
instabilities be encountered, they are also displayed. You can scroll through the messages 
displayed using the scroll bars at the side of the Solver window.

• To pause the solution process, choose the SUSPEND button. Your can then choose to 
cancel the solution process or continue by choosing the corresponding command button.

Figure 3-38 spFrame Solver Window

When the solver is done, choose the CLOSE button to start the LOCAL PROCESS.  LOCAL 
PROCESS will process all elements and close automatically. 
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3.48 View Joint Results

Analyze/Joint Results command allows you to view joint displacements and rotations as well as 
member end forces and moments. Joint displacements and rotations are referenced in the global 
coordinate system and member end forces are referenced in the local coordinate system.

• From the Analyze menu, select Joint Results. The box of Figure 3-39 appears.

• From the COMBINATION drop-down list, select the load combination whose results are 
to be displayed.

• From the OPTIONS drop-down list, select joint displacements (Dx, Dy, and Dz), joint 
rotations (Rx, Ry, and Rz), end forces (Fx, Fy, and Fz), or end moments (Mx, My, Mz).

• From the FORMAT drop-down list, specify the format to present the numerical values—
general, exponential (scientific), or floating point format.

Figure 3-39 Joint Results list box

• Use the scroll bars on the side of the list box, or the keyboard direction keys, to scroll 
through the list.

• To exit, choose CLOSE from the Control-menu box of the box, press ENTER, or press 
ALT+F4.

3.49 View Support Reactions

Analyze/Support Reactions command allows you to view the applicable support reactions—
forces (Fx, Fy, and Fz) and moments (Mx, My, and Mz). These results are referenced in the global 
coordinate system.

• From the Analyze menu, select Support Reactions. The box of Figure 3-40 appears.
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• From the COMBINATION drop-down list, select the load combination whose results are 
to be displayed.

• From the FORMAT drop-down list, specify the format to present the numerical values—
general, exponential (scientific), or floating point format.

• Use the scroll bars on the side of the list box, or the keyboard direction keys, to scroll 
through the list.

• To exit, choose Close from the Control-menu box of the box, press ENTER, or press 
ALT+F4.

Figure 3-40 Support Reactions list box

3.50 View/Print Member Results

Analyze/Member Results command allows you to view and/or print member local results in 
graphical or text format.

• From the Analyze menu, select Member Results. The box of Figure 3-41 appears.

• From the MEMBER LIST list box, select a member.

• From the LOAD COMBINATIONS drop-down list, select the load combination whose 
results are to be displayed.

• From the RESULT OPTIONS drop-down list, select one of the applicable results to 
display. Choices are in-plane shear (Fy), in-plane moment (Mz), in-plane deflection (dy), 
axial force (Fx), out-of-plane shear (Fz), out-of-plane moment (My), out-of-plane 
deflection (dz), and torsion (Mx). These results are referenced in the member local 
coordinate system.

• A graphical plot of the result option is shown. The horizontal axis represents the member 
length with the member start joint (J1) being on the left and the member end joint (J2) on 
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the right. The vertical axis represents the result option selected. Also shown on the graph 
are the minimum and maximum values of the result option along with the member length.

Figure 3-41 Member Results dialog box

Values Choosing the VALUES button displays a list box (shown in Figure 3-42) that shows the 
numerical values of all the applicable results options. Results are computed at 100 locations along 
a member length. The Offset % in the title refers to the ratio of the result location from joint J1 to 
the member length in percentage. The VALUES list box is resizable and movable.

Use the vertical and horizontal scroll bars (or the PGUP, PGDN, UP, DOWN, LEFT, and RIGHT 
ARROW keys) to scroll through the list. Choose CLOSE from the Control menu box of the list 
box or press ALT+F4 to exit when done. Note that if you select another member in the MEMBER 
LIST list box of the MEMBER RESULTS dialog box, the values list is updated to show the 
selected member results.

Figure 3-42 Member Results Values list box
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3.50.1 Summary

Choosing the SUMMARY button displays a summary of the member information (Figure 3-43). 
The summary includes member definitions and assignments, member end forces and moments, 
minimum and maximum values of the member forces, and moments and deflections along with 
their corresponding locations (from the member start joint, J1). The SUMMARY list box is re-
sizable and movable.

Figure 3-43 Member Summary list box

Use the vertical and horizontal scroll bars (or the PGUP, PGDN, UP, DOWN, LEFT, and RIGHT 
ARROW keys) to scroll through the list. Choose CLOSE from the Control menu box of the list 
box or press ALT+F4 to exit when done. Note that if you select another member in the MEMBER 
LIST list box of the MEMBER RESULTS dialog box, the summary list box is updated to show the 
selected member results

3.50.2 Print

Choosing the PRINT button displays the dialog box of Figure 3-44. You can print selected 
diagrams of the applicable result options (in-plane and out-of-plane moment, shear, deflection, 
axial force, or torsion), their segmental values (at 21 locations along the member length), and a 
summary of the member data. Choose OK to start printing or CANCEL to abort. The output is 
directed to the active printer.
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Figure 3-44 Print Options dialog box

3.51 View/Print Result Envelopes

Analyze/Envelopes command allows you to view and print the envelope values of member local 
results in graphical and text format. Envelope results represent the minimum and maximum values 
of all defined load combinations.

• From the Analyze menu, select Envelopes. The dialog box of Figure 3-45 appears.

• From the MEMBER LIST list box, select a member.

• From the OPTIONS drop-down list, select one of the applicable results to display. Choices 
are in-plane shear (Fy), in-plane moment (Mz), axial force (Fx), out-ofplane shear (Fz), 
out-of-plane moment (My), and torsional moment (Mx). These results are referenced in 
the member local coordinate system.

Figure 3-45 Envelopes dialog box

• The graphical plot of the result option is shown in two different colors representing the 
minimum and maximum values. The horizontal axis of the graph represents the member 
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length with the member start joint (J1) being on the left and the member end joint (J2) on 
the right. The vertical axis represents the result option selected. Also shown on the graph 
are the minimum and maximum values of the result option along with the member length.

3.51.1 Values

Choosing the VALUES button displays a list box (shown in Figure 3-46) that shows the numerical 
values of all the applicable results options. Results are computed at 100 locations along a member 
length. The Offset% in the title refers to the ratio of the result location from joint J1 to the member 
length in percentage. The VALUES list box is re-sizable and movable.

Figure 3-46 Envelope Values list box

Use the vertical and horizontal scroll bars (or the PGUP, PGDN, UP, DOWN, LEFT, and RIGHT 
ARROW keys) to scroll through the list. Choose CLOSE from the Control menu box of the list 
box, or press ALT+F4 to exit when done. Note that if you select another member in the MEMBER 
LIST list box of the ENVELOPES dialog box, the values list is updated to show the selected 
member results.

3.51.2 Print

Choosing the PRINT button displays the dialog box of Figure 3-47. You may print selected 
diagrams of the applicable result options (in-plane and out-of-plane moment and shear, axial 
force, or torsion) as well as their segmental values (at 11 locations along the member length). 
Choose OK to start printing or CANCEL to abort. The output is directed to the active printer.

3.52 View Group Results

Analyze/Group Results command allows you to view and/or print the results for the member 
groups (defined using the Process/Member Group command) in graphical and text format. Group 
results represent the minimum and maximum values of all grouped members under all defined 
load combinations (i.e. envelope of envelopes).
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• From the Analyze menu, select Group Results. The dialog box of Figure 3-47 appears.

• From the GROUP LIST list box, select a group.

• From the OPTIONS drop-down list, select one of the applicable results to display. Choices 
are in-plane shear (Fy), in-plane moment (Mz), axial force (Fx), out-of plane shear (Fz), 
out-of-plane moment (My), and torsional moment (Mx). These results are referenced in 
the member local coordinate system.

• The graphical plot of the result option is shown in two different colors representing the 
minimum and maximum values. The horizontal axis of the graph represents the member 
length with the member start joint (J1) being on the left and the member end joint (J2) on 
the right. The vertical axis represents the result option selected. Also shown on the graph, 
the minimum and maximum values of the result option.

Figure 3-47 Print Options dialog box

3.53 Define Zoom Command

Show/Zoom command enables you to enlarge or reduce the image of the model in the Graphics 
window. It allows you to look at a detail of the model. This command is used for display purposes 
only and does not affect the model geometry.

• From the Show menu, choose Zoom. Note that this command stays in effect until you 
clear it. 

3.53.1 Using the mouse 

• To zoom in (enlarge), using the left-mouse button, marquee select a portion of the 
graphical image. The selected area occupies the entire Graphics area.

• To zoom out (reduce), using the right-mouse button, marquee select a portion of the 
graphical image. The viewport is adjusted in proportion to the selected area to the 
Graphics area.



OPERATING spFrame

| 104 |

3.53.2 Using the keyboard

• Use the CTRL+PGUP to zoom in and CTRL+PGDN to zoom out. To move the viewport 
left, right, up, or down, press CTRL+LEFT, CTRL+RIGHT, CTRL+UP, or 
CTRL+DOWN, respectively. These keyboard assignments are always active, regardless 
of the Zoom command status.

3.53.3 To reset the zoom

• To reset the display to its original scale, choose the Show/Reset command.

3.54 Rotate Graphical Image

Show/Rotate command enables you to rotate the displayed image so that you may look at the 
model from a different viewpoint. This command works closely with the axis orientation box 
located at the top of the Tool bar. This command is used for display purposes only and does not 
affect the model geometry.

• From the Show menu, select Rotate. Note that this command stays in effect until you 
clear it.

3.54.1 Using the mouse 

• Click and hold the left-mouse button. Drag the mouse in any direction while holding the 
left button. Notice the rotation of the axis orientation box in the Tool bar. Its position 
represents the position of the model as soon as you release the left-mouse button.

3.54.2 Using the keyboard

• Use the UP, DOWN, LEFT, or RIGHT ARROW keys to rotate the model. Press the + 
(plus) key to increase the rotation increment or the - (minus) key to decrease it. These 
keyboard assignments are always active, regardless of the Rotate command status.

3.54.3 To reset the rotation

• To reset the rotation to its default orientation, select the Show/Reset command.

3.55 Translate Graphical Image

Show/Translate command enables you to move the displayed image around the screen. Image 
translation is a linear movement of the viewport. This command is used for display purposes only 
and does not affect the model geometry.
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• From the Show menu, select Translate. Note that this command stays in effect until you 
clear it.

3.55.1 Using the mouse

• Click and hold the left-mouse button. As you drag the cursor around the Graphics area, a 
line representing the new relative location of the viewport appears. Translation is made 
when you release the left-mouse button.

3.55.2 Using the keyboard

• Use the CTRL+UP, CTRL+DOWN, CTRL+LEFT ARROW, or CTRL+RIGHT ARROW 
key combination to move the viewport up, down, left, or right, respectively. Press 
CTRL++ (CTRL and the plus key) to increase the translation increment or CTRL+- 
(CTRL and the minus key) to decrease it. These keyboard assignments are always active, 
regardless of the Translate command status.

3.55.3 To reset translation

• To reset the translation to its default position, select the Show/Reset command.

3.56 View Stereoscopic Mode

Show/Stereo command switches the display to 3-D Stereoscopic mode. The special blue-red 
filtering glasses provided with the program package are needed for this feature. The Stereo 
command works on a color monitor only.

In complex models, the orientation of the image on the screen may be difficult to visualize. Using 
the filtering glasses, you will be able to distinguish between the lines in the foreground and those 
in the background.

• From the Show menu, select Stereo.

• Rotate the model slightly from its default orientation and focus on one point within the 
model for a duration of 10 to 20 seconds.

• As you rotate the model, you will be able to detect the 3-D effect.

• To cancel the 3-D Stereoscopic mode and return to normal viewing mode, select the 
Stereo command from the Show menu.
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3.57 Define Reset Command

Show/Reset command enables you to return the displayed image to its original settings after a 
zoom, rotation, or translation. The command resets the functions of the Zoom, Rotate, or Translate 
commands, whichever is active. However, the keyboard assignments associated with these 
commands are always active.

3.58 Define Freeze/Thaw Command

Show/Freeze/Thaw command enables you to temporarily freeze the graphic image generation. 
Selecting the command for the first time resets the image and causes the generation of joints and 
members only. It is generally used when the display generation time is too long and you want to 
change some display settings (e.g. orientation) without waiting for the whole model display to be 
completed.

• From the Show menu, select Freeze/Thaw. Any display generation that is taking effect 
stops and only the joints and members of the model are redrawn.

• To reset the display or thaw it, select the command again. The model, with whatever 
settings selected, are redrawn. You can toggle the command between freeze and thaw 
actions as often as you like.

3.59 View Selected Graphical Image

Show/Select command enables you to select and tag part of the model to be displayed (rather than 
displaying the whole model). This command works in conjunction with the Show/Hide/Show 
command. It is generally used when you have a model with a large number of members. 
Superimposing the shear or moment diagrams on such a model makes the display very crowded 
and unclear. In this case, using the Select command, select a portion of the model by tagging the 
members of interest to you, then use the Show/Hide command to show this portion and hide the 
rest of the model.

• From the Show menu, select Select. Once the command is active, the displayed model is 
grayed (or shown as dotted lines).

• To tag a single member, click the left-mouse button on that member. Notice that the 
member is redrawn using solid lines.

• To tag a group of members, marquee select them. Only members fully enclosed in the 
marquee will be selected. Selected members are shown in solid lines.
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• To un-tag a member or a group of members, use one of the two procedures described 
above using the right-mouse button. The un-tagged members are redrawn using grayed 
lines.

• Using the keyboard, tag joints and members while defining them using the Process/Joints 
and Process/Members commands.

Once you tag a portion of the model, you may hide or show the rest of it by using the Hide/Show 
command.

• From the Show menu, select Hide/Show.

• All un-tagged members and joints are removed from the display, and only the tagged 
portion of the model is displayed with the current settings.

• To display the whole model, select the Hide/Show command again. 

3.60 Define Preferences Command

Show/Preferences command enables you to select the information to be shown on the graphical 
image. By default, joints are shown as small squares and members are shown as solid lines. You 
can however select to display the joint numbers (labels), member numbers (labels), support 
fixities, and member orientation. Joints, members, and fixities colors can be changed from the 
Options/Color command.

• From the Show menu, select Preferences. The dialog box of Figure 3-48 appears.

• Select the check-box options you wish to display or clear the unwanted options. Your 
choices are JOINTS, MEMBER LABELS, FIXITIES, and ORIENTATION.

Figure 3-48 Preferences dialog box

3.60.1 Joint Numbers

• If selected, you may choose to show joint labels or show joints as small squares by 
selecting the corresponding option button.
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3.60.2 Member Number

• If selected, member labels are placed at the center of each member.

3.60.3 Fixities

• If selected, three short lines denoting the global axes are drawn at each fixed joint. A 
translational fixity along an axis is represented by a cross at the end of the line 
representing that axis. A rotational fixity about an axis is shown as a cross in the middle of 
the line representing that axis.

3.60.4 Orientation

• If selected, member orientation is shown as a simulated box section extending along the 
member length. In 3-D orientation, you are able to see three sides of the orientation box, 
each with a different color. The two sides parallel to the member centerline represent the 
planes perpendicular to the minor (local y) and major (local z) axes of the members and 
their colors are light green and dark green, respectively.

• Choose the OK button.

3.61 Superimpose Loads on Graphical Image

Show/Load Diagrams command enables you to superimpose defined member and joint applied 
loads on the model. The scale used to display the loads is set to a predetermined value. This may 
cause the loads to be shown too small or too large with respect to the model. In such a case you 
should adjust the scale to suit your viewing needs.

• From the Show menu, select Load Diagrams. The dialog box of Figure 3-49 appears.

Figure 3-49 Load Diagrams dialog box

• From the LOAD CASE drop-down list box, select the load case whose loads are to be 
displayed.
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• Select the type of load you want displayed, point loads or uniform loads by selecting the 
corresponding check-box option.

• For each option selected, input a factor to be used in scaling the displayed loads. Input the 
factor in the FACTOR text box.

• Choose the OK button.

Point and uniform loads are displayed in different colors. Load colors can be changed from the 
Options/Color command.

3.62 Superimpose Results on Graphical Image

Show/Result Diagrams command enables you to superimpose the results of a successful analysis 
on the model. Since the results values are relative, a scaling factor must be input. If the scaling 
factor is assigned a zero value, the program calculates it automatically. Selected results are 
displayed with different colors. Displayed results colors can be changed from the Options/Color 
command.

• From the Show menu, select Result Diagrams. The dialog box of Figure 3-50 appears.

• From the COMBINATION drop-down list box, select the load combination whose results 
are to be displayed.

3.62.1 To show deflections

• In the DEFORMED SHAPE group, select the check-box options that you want.

• SHOW DEFORMED option displays the simulated deformed shape of the model, i.e., 
only joint displacements are displayed and the members are still shown as straight lines 
connecting the displaced joints.
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Figure 3-50 Results Diagrams dialog box

• TRUE SHAPE option displays the true deflected shape of the model that represents the 
local deflection of the member. This option is valid for members that have been locally 
processed.

• REMOVE ORIGINAL option causes the display of the deflected shape without the 
original model. By default, the original structure is shown in dashed lines, and the 
deflected shape is shown in solid lines.

• In the FACTOR text box, input a scale factor. A value of zero forces automatic calculation 
of that factor.

3.62.2 To show shear results

• In the SHEAR ENVELOPE group select the SHOW SHEAR check-box option. This 
option is valid for members that have been locally processed.

• In the FACTOR text box, input a scale factor. A value of zero forces automatic calculation 
of that factor.

• Select whether the shear to be displayed is in-plane or out-of-plane by choosing the 
corresponding option button.

3.62.3 To show moment results

• In the MOMENT ENVELOPE group select the SHOW MOMENT check-box option. 
This option is valid for members that have been locally processed.

• In the FACTOR text box, input a scale factor. A value of zero forces automatic calculation 
of that factor.

• Select whether the moment to be displayed is in-plane or out-of-plane by choosing the 
corresponding option button.
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• Choose the OK button.

3.63 Access Member Information

Show/Member Info command displays an information window that can be used to obtain 
important data about any defined member.

• From the Show menu, select Member Info.

• MEMBER INFORMATION window shown in Figure 3-51 appears. The window is 
movable and it displays the member label, start joint, end joint, computed length, assigned 
material, assigned section, assigned non-prismatic definition, and assigned angle of 
rotation.

Figure 3-51 Member Information window

• To get information about a member, place the cursor near the center of the member and 
click the left-mouse button.

• To close the Member Information window, select Close from its control-menu box or 
press ALT+F4.

3.64 Save Settings

Options/Save Settings command enables you to save the current file settings to be used in future 
input sessions. Default settings are saved in the Windows registry file. Settings saved include units 
of measure, DEFAULT material, DEFAULT section, DEFAULT orientation angle, and window 
color settings.

3.65 Color

Options/Color command enables you to change the color settings of your spFrame window.

• From the Options menu, select Color. The dialog box of Figure 3-52 appears. You can 
change the color of the displayed joints, members, translational fixities, rotational fixities, 
point loads, distributed loads, result moment, and result shear. To change the color of an 
option, open the list box associated with it, and select a new color from the drop-down list.
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• You can also select a black or white background for the whole spFrame window by 
choosing the corresponding option button in the BACKGROUND option group.

• Choose the OK button.

Figure 3-52 Color Setting dialog box

3.66 Autosave

Options/Autosave command enables you to force the program to save your input data to disk at 
certain time intervals. This feature is useful when working with a large model that takes a long 
time to input. It minimizes data loss in case of a power loss or computer lock-up.

• From the Options menu, select Autosave. The dialog box of Figure 3-53 appears.

Figure 3-53 Autosave dialog box

• In the FREQUENCY text box, enter the time interval (in minutes).

• Select the AUTOSAVE ACTIVE check-box option to activate the autosave feature, or 
clear it to deactivate it.

• Select or clear the Compress Data Files option. When this option is selected, output data 
files will be compressed when you save the file after solving, thus, saving considerable 
amount of disk space. Compressed files are automatically expanded (decompressed) when 
you open the file again.

• Choose the OK button.
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4.1 Introduction

A two-story structure (floor plan shown in Figure 4-1) is subjected to the lateral loads shown in 
Figure 4-3. The superimposed dead and live gravity loads are shown in Figure 4-2 are in addition 
to the self weight of columns and walls. All columns are 16" x 16", E-W beams are 16" x 20", N-
S beams are 16" x 24", and all walls are 16" thick. Beams, columns, and walls are of normal 
weight concrete (w = 145 pcf and Ec = 3600 ksi).

Corrections for shear deformations will be considered for the shearwalls. The shape factor for the 
wall rectangular section is 1.2. E-W beams framing into the walls will be assigned rigid-end 
offsets at their ends framing into the wall. The rigid-end offset is half the width of the support, 30 
in.

Figure 4-1 Typical Floor Plan



TUTORIAL

| 115 |

Figure 4-2 Gravity Load on Beams

Figure 4-3 Lateral Loads on Frame
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4.2 Define Labels and Structure Type

• From the Define menu, choose Type.

• From the STRUCTURE TYPE options group, select 3-D FRAME.

• In the corresponding text boxes, enter the project title and engineers initials.

• Press ENTER or choose OK.

4.3 Define Units

• From the Define menu, choose Units.

• Select ENGLISH.

• Open the LENGTH drop-down list and select ft.

• Open the drop-down list boxes needed and select the appropriate units (see the following 
Figure 4-4 for the units used in this example).

Figure 4-4 Define Units

• Press ENTER or choose OK.

4.4 Define Defaults

We will assign the material properties to the DEFAULT material, the member orientation to the 
DEFAULT orientation angle, and the column section properties to the DEFAULT section.

• From the Define menu, choose Defaults.
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Figure 4-5 Define Defaults

• In the MODULUS OF ELASTICITY text box, enter 3600.

• In the DENSITY text box, enter 145.

• In the AREA text box, enter 256.

• In the MOMENT OF INERTIA, IZ text box, enter 5461.

• In the MOMENT OF INERTIA, IY text box, enter 5461.

• In the POLAR MOMENT OF INERTIA, J text box, enter 10923.

• In the POISSON’S RATIO text box, enter 0.2.

• In the THERMAL COEFFICIENT text box, enter 0.

• In the ORIENTATION ANGLE text box, enter 0.

• Press ENTER or choose OK.

4.5 Define Section Properties

• From the Define menu, choose Sections.



TUTORIAL

| 119 |

Figure 4-6 Define Section Properties

• Open the TYPE drop-down list and select RECTANGULAR.

• In the LABEL text box, enter BeamNS.

• In the WIDTH text box, enter 16.

• In the DEPTH text box, enter 24.

• Press ENTER or choose ADD.

• In the LABEL text box, enter BeamEW.

• In the WIDTH text box, enter 16.

• In the DEPTH text box, enter 20.

• Press ENTER or choose ADD.

• In the LABEL text box, enter Wall.

• In the WIDTH text box, enter 16.

• In the DEPTH text box, enter 60.

• Press ENTER or choose ADD.

• Choose OK.
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4.6 Define Member Loads

• From the Define menu, choose Loads.

• From the ORIENTATION options group, select GLOBAL.

• From the DIRECTION options group, select Y.

• In the LABEL text box, enter DistD.

• From the TYPE options group, select DISTRIBUTED LOAD.

• In the INTENSITY text box, enter -2.7.

• In the DISTANCE FROM J1/LENGTH text box, enter 0.

• In the LOAD LENGTH/LENGTH text box, enter 1.

• Press ENTER or choose ADD.

• In the LABEL text box, enter DistL.

• In the INTENSITY text box, enter -1.2.

• Leave the values in the other two text boxes as 0 and 1.

• Press ENTER or choose ADD.

• In the LABEL text box, enter PointD.

• From the TYPE options group, select POINT LOAD.

• In the INTENSITY text box, enter -35.

• In the DISTANCE FROM J1/LENGTH text box, enter 0.5.

• Press ENTER or choose ADD.

• In the LABEL text box, enter PointL.

• In the INTENSITY text box, enter -20.

• Leave the values in the other text boxes as 0.5.

• Press ENTER or choose ADD.

• Choose OK.

4.7 Define Load Cases

• From the Define menu, choose Load Cases.

• In the LABEL text box, enter Dead and press ENTER or choose ADD.

• In the LABEL text box, enter Live and press ENTER or choose ADD.
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Figure 4-7 Define Load Cases

• In the LABEL text box, enter Lateral and press ENTER or choose ADD.

• Choose OK.

4.8 Define Joints

• From the Process menu, choose Joints.

• In the LABEL text box, enter 1.

• Enter 0, 0, and 0 in the X, Y, and Z text boxes, respectively.

• Press ENTER or choose ADD.

• Choose the GENERATE button.

• Enter 1, 1, 2, 20, 0, and 0 in the FROM JOINT, TO JOINT, QUANTITY, DELTA X, 
DELTA Y, and DELTA Z text boxes, respectively.

• Press ENTER or choose OK. Joints 2 and 3 are generated.

• Choose the GENERATE button.

• Enter 1, 3, 2, 0, 0, and 15 in the FROM JOINT, TO JOINT, QUANTITY, DELTA 
X, DELTA Y, and DELTA Z text boxes, respectively.

• Press ENTER or choose OK. Joints 4 through 9 are generated.
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Figure 4-8 Define Joints

• Choose the GENERATE button.

• Enter 1, 9, 1, 0, 18, and 0 in the FROM JOINT, TO JOINT, QUANTITY, DELTA 
X, DELTA Y, and DELTA Z text boxes, respectively.

• Press ENTER or choose OK. Joints 10 through 18 are generated.

• Choose the GENERATE button.

• Enter 10, 18, 1, 0, 15, and 0 in the FROM JOINT, TO JOINT, QUANTITY, 
DELTA X, DELTA Y, and DELTA Z text boxes, respectively.

• Press ENTER or choose OK. Joints 19 through 27 are generated.

• Choose OK.

4.9 Define Supports

• From the Process menu, select Fixities.

• From the JOINT LIST list box, select joints 1 through 9.

• In the FIXITIES options group, select all check-box options (every box should have an X 
inside it).

• Press ENTER or choose ADD.

• Choose OK.
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Figure 4-9 Define Supports

4.10 Define Members

• From the Process menu, select Members.

• In the LABEL text box, enter 1.

• In the START text box, enter 1 (or select 1 from the START list box).

• In the END text box, enter 10 (or select 10 from the END list box).

• Press ENTER or choose ADD.

• Choose the GENERATE button.

• Enter 1, 1, 1, 1, and 17 in the FROM MEMBER, TO MEMBER, DELTA J1, 
DELTA J2, and QUANTITY text boxes, respectively.

• Choose OK. Members 2 through 18 are generated.
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Figure 4-10 Define Members

• In the LABEL text box, enter 19.

• In the START text box, enter 10 (or select 10 from the START list box).

• In the END text box, enter 11 (or select 11 from the END list box).

• Choose ADD.

• In the LABEL text box, enter 20.

• In the START text box, enter 11 (or select 11 from the START list box).

• In the END text box, enter 12 (or select 12 from the END list box).

• Press ENTER or choose ADD.

• Choose the GENERATE button.

• Enter 19, 20, 3, 3, and 5 in the FROM MEMBER, TO MEMBER, DELTA J1, 
DELTA J2, and QUANTITY text boxes, respectively.

• Press ENTER or choose OK. Members 21 through 30 are generated.

• In the LABEL text box, enter 31.

• In the START text box, enter 10 (or select 10 from the START list box).

• In the END text box, enter 13 (or select 13 from the END list box).

• Choose ADD.

• In the LABEL text box, enter 32.

• In the START text box, enter 13 (or select 13 from the START list box).

• In the END text box, enter 16 (or select 16 from the END list box).

• Press ENTER or choose ADD.

• Choose the GENERATE button.

• In the dialog box, enter 31, 32, 1, 1, and 2 in the FROM MEMBER, TO MEM-
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BER, DELTA J1, DELTA J2, and QUANTITY text boxes, respectively.

• Press ENTER or Choose OK. Members 33 through 36 are generated.

• Choose the GENERATE button.

• Enter 31, 36, 9, 9, and 1 in the FROM MEMBER, TO MEMBER, DELTA J1, 
DELTA J2, and QUANTITY text boxes, respectively.

• Press ENTER or choose OK. Members 37 through 42 are generated.

• Choose OK.

4.11 Assign Member Types

Note that since we defined the column section properties to the DEFAULT section, we need not 
assign member types to the columns.

• From the Process menu, choose Member Types.

• Open the SECTION TYPE drop-down list and select WALL.

• From the Members List list box, select members 2, 8, 11, and 17.

• Press ENTER or choose ADD.

• Open the SECTION TYPE drop-down list and select BEAMEW.

• From the MEMBERS LIST list box, select members 19, through 30.

• Press ENTER or choose ADD.

• Open the SECTION TYPE drop-down list and select BEAMNS.

• From the MEMBERS LIST list box, select members 31 through 42.

• Press ENTER or choose ADD.

• Choose OK.

4.12 Assign Shear Correction Factors

• From the Process menu, choose Shear Corrections.
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Figure 4-11 Assign Shear Corrections

• In the SHAPE FACTOR text box, enter 1.2.

• From the MEMBERS LIST list box, select members 2, 8, 11, and 17.

• Press ENTER or choose ADD.

• Choose OK.

4.13 Assign Rigid-end Offsets

• From the Process menu, choose Rigid-end Offsets.

• From the MEMBERS LIST list box, select members 19, 21, 23, 25, 27, and 29.

• In the DI text box, enter 0.

• In the DJ text box, enter 30.

• Press ENTER or choose ADD.

• From the MEMBERS LIST list box, select members 20, 22, 24, 26, 28, and 30.
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Figure 4-12 Assign Rigid-end Offsets

• In the DI text box, enter 30.

• In the DJ text box, enter 0.

• Press ENTER or choose ADD.

• Choose OK.

4.14 Define Rigid Diaphragms

• From the Process menu, choose Rigid Diaphragm.

• From the ELEVATION drop-down list, select 18. All horizontal members (beams) that 
exist at that elevation are displayed in the MEMBER LIST list box.
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Figure 4-13 Define Rigid Diaphragms

• Choose INCLUDE ALL. The horizontal members are added to the SELECTED 
MEMBERS list box.

• From the ELEVATION drop-down list, select 33. All horizontal members that exist at 
that elevation are displayed in the MEMBER LIST list box.

• Choose INCLUDE ALL. The horizontal members are added to the SELECTED 
MEMBERS list box.

• Choose OK.

4.15 Assign Member Loads

• From the Analyze menu, select Member Loads.

• Open the LOAD CASE drop-down list and select DEAD.
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Figure 4-14 Assign Member Loads

• From the LOAD LIST list box, select DISTD.

• Choose INCLUDE.

• From the MEMBER LIST list box, select members 19 through 30.

• Choose ADD.

• From the LOAD LIST list box, select POINTD.

• Choose INCLUDE.

• From the SELECTED LOADS list box, select DISTD.

• Choose REMOVE.

• From the MEMBER LIST list box, select members 31 through 42.

• Choose ADD.
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• Open the LOAD CASE drop-down list and select LIVE.

• From the LOAD LIST list box, select DISTL.

• Choose INCLUDE.

• From the MEMBER LIST list box, select members 19 through 30.

• Choose ADD.

• From the LOAD LIST list box, select POINTL.

• Choose INCLUDE.

• From the SELECTED LOADS list box, select DISTL.

• Choose REMOVE.

• From the MEMBER LIST list box, select members 31 through 42.

• Choose ADD.

• Choose OK.

4.16 Input Joint Loads

Lateral load will be input as joint loads.

• From the Analyze menu, select Joint Loads.

• Open the LOAD CASE drop-down list and select LATERAL.

• In the FX text box, enter 20.

• From the JOINTS LIST list box, select 22.

• Choose ADD.

• In the FX text box, enter 15.

• From the JOINTS LIST list box, select 13.

• Choose ADD

• Choose OK.
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Figure 4-15 Input Joint Loads

4.17 Assign Member Self Loads

• From the Analyze menu, select Self Loads.

• From the MEMBER LIST list box, select members 1 through 18.

• Press ENTER or choose ADD.

• Choose OK.
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Figure 4-16 Assign Member Self Loads

4.18 Define Load Combinations

• From the Analyze menu, select Load Combinations.

• In the LABEL text box, enter 1.4(D+L).

• From the LOAD CASE list box, select SELF, DEAD, and LIVE.

• In the FACTOR text box, enter 1.4.

• Choose INCLUDE. Factored load cases are added to the FACTORED CASES list 
box.

• Choose ADD. The combination is added to the list box at the bottom.

• In the LABEL text box, enter 1.0W.

• From the FACTORED CASES list box, select 1.4 SELF, 1.4 DEAD, and 1.4 
LIVE.
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Figure 4-17 Define Load Combinations

• Choose REMOVE.

• From the LOAD CASE list box, select LATERAL.

• In the FACTOR text box, enter 1.0.

• Choose INCLUDE. The factored load case is added to the FACTORED CASES list 
box.

• Choose ADD. The combination is added to the list box at the bottom.

• In the LABEL text box, enter D+L+W.

• From the LOAD CASE list box, select SELF, DEAD, and LIVE.

• In the FACTOR text box, enter 1.0.

• Choose INCLUDE. Factored load cases are added to the FACTORED CASES list 
box.

• Choose ADD. The combination is added to the list box at the bottom.

• Choose OK.

4.19 Solve Model

• From the Analyze menu, select Solve.

• Leave all options to their default settings and choose the SOLVE button.
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• Solver window displays the solution progress.

• When the solver is done, choose the CLOSE button.

4.20 Member Grouping

To group the first floor columns in one group

• From the Process menu, select Member Group.

• In the Label text box, enter 1STCOL.

• From the MEMBER LIST, select members 1 through 9.

• Choose the INCLUDE button. The members are added to the SELECTED MEM-
BERS list box.

• In the SELECTED MEMBERS list box, select members 2 and 8 and choose the 
REMOVE button.

• Choose the ADD button. The defined group is added to the list box at the bottom.

• Choose the OK button.

4.21 View Results

• From the Analyze menu, select Joint Results.

• From the COMBINATION drop-down list, select the load combination whose 
results are to be listed.

• From the OPTIONS drop-down list, select the result option to be listed.

• The selected option results are displayed in the list box. Use the scroll bars to move 
through the list.

• Press ALT+F4 to close the window.

• From the Analyze menu, select Support Reactions.

• From the COMBINATION drop-down list, select the load combination whose results 
are to be listed.

• Press ALT+F4 to close the window.
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• From the Analyze menu, select Member Results.

• From the LOAD COMBINATIONS drop-down list, select the load combination 
whose results are to be viewed.

• From the RESULT OPTIONS drop-down list, select a result option (e.g. MOMENT 
IN-PLANE, MZ).

• From the MEMBER LIST list box, select a member (e.g. 28).

• To view a member summary, choose the SUMMARY button.

• To print results, choose the PRINT button.

• Choose the CLOSE button to close all open windows.

• From the Analyze menu, select Envelopes.

• From the OPTIONS drop-down list, select a result option (e.g. MOMENT IN-
PLANE, MZ).

• From the MEMBER LIST list box, select a member (e.g. 6).

• To view the list of results values, choose the VALUES button.

• To print the envelopes values or diagram, choose the PRINT button.

• Choose the CLOSE button to close all open windows

• From the Analyze menu, select Group Results.

• From the OPTIONS drop-down list, select a result option (e.g. MOMENT IN-
PLANE, MZ).

• To view the list of results, choose the VALUES button.

• To print the group envelopes or diagrams, choose the PRINT button.

• Choose the CLOSE button to close all open windows.

• From the Show menu, select Rotate.

• From the Show menu, select Reset. The 3-D view is reset to its default rotation whereas 
the XY plane is in the plane of the monitor screen.

• From the Show menu, select Select. The model is drawn in dashed lines.

• Marquee select the line of columns on the far left side of the model. The selected por-
tions are redrawn in solid lines.

• From the Show menu, select Hide/Show. Only the selected portion of the model will 
be shown.

• From the Show menu, select Rotate. Click the left-mouse button anywhere within the 
Graphics area and drag the mouse pointer towards the upper right-hand corner of the 
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monitor. Notice the axis rotation (shown in the upper left-hand corner of the window). 
Release the mouse button when satisfied with the rotation.

• From the Show menu, select Result Diagrams.

• In the dialog box, choose SHOW MOMENT.

• Choose OK. The moment diagrams are superimposed on the model.

• To show the entire model again, select the Hide/Show command from the Show 
menu.

• To print the screen image, select the Print Screen command from the File menu.

4.22 Print Results

• From the File menu, select Print Results.

• In the dialog box, select the options you want.

• Choose PRINT.
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5.1 Introduction

The structural model, which may be created using spCad, is fully described in Chapter 2. The 
global and local coordinate systems adopted in spFrame are used in spCad as well.

Figure 5-1 Coordinate Systems

Similar to spFrame, member properties (material, section, and non-prismatic) and load data 
(member loads, load cases, and load combinations) are input using the Define menu commands. 
These entries may be saved in databases or library files so that they can be used in other data files. 
The member properties and load definitions may also be retrieved from library files that may have 
been created for previous projects. A full description of these entries and their input is detailed in 
the spFrame user’s manual.

One of spCad’s main features is the ease of generating the geometry of a structure through its 
graphic interface and drawing capabilities. Using CAD’s Plane editor, members may be drawn 
directly on the screen and may also be copied a number of times to speed up model generation. 
While copying members and joints, varying offsets and varying rotation (both in-plane and out-of-
plane), are permitted to enable fast modeling of the most complex structures.

Supports, member properties, joint loads, member loads, and model refinement (such as rigid-end 
offsets, shear corrections, etc.), are graphically assigned to the joints and members using the 
Assign menu commands. Changing an assignment is done by reapplying it.

spCad includes options that are not available in spFrame. spCad offers the ability to generate 
lateral loads (wind or seismic) for a building structure, and the ability to input surface loads which 
can be converted to uniform member loads. From the surface loads input, the tributary areas of 
beams and columns are also computed and the reduction factor for a live load case may be saved 
with the data file.
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5.2 Plane Editor

Any frame or truss structure may be divided into a group of two-dimensional planes in the global 
coordinate system. Figure 5-1 Coordinate Systems shows the three planes of the Plane editor and 
their orientation. These planes may be parallel to the XY (elevations), YZ (elevations), or XZ 
(floors) planes of the global coordinate system.

Working in one plane at a time, in-plane joints and members are drawn directly on the screen by 
simple mouse button clicks. Joints and members may also be moved or deleted.

5.2.1 Planes

• A plane is defined by its coordinate, i.e., orthogonal distance from the origin.

• A plane must have a unique label. Default plane labels are based on the plane coordinate.

• For a plane to exist and be valid, it must contain at least one joint.

• As joints and members are drawn or generated, 

• spCad creates all possible XY, XZ, and YZ planes that contain them.

• Deleting a plane deletes all joints in that plane along with all connected members.

• A plane’s coordinate may be changed to any value as long as it stays between the 
coordinates of the two planes immediately before and after it.

5.2.2 Joints

• A joint is drawn by clicking on its location on the screen.

• No two joints may have the same coordinates.

• Deleting a joint deletes all members connected to it.

• Moving a joint moves all members connected to it.

• Joints are labeled with numbers based on their order of input.
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Figure 5-2 Three planes of the plane editor

5.2.3 Members

• A member has a joint at each of its ends.

• To draw a member, click on the first location, move to the second location, and click 
again. If there is no joint where you click, one will be created.

• No two members may have the same Start and End joints.

• Deleting a member does not delete its end joints.

• Moving a member does not move its end joints but rather creates two new joints.

• Adding a joint along a member divides the member into two.

• Members are labeled with numbers based on their order of input.

• The end of a member closest to the joint with the lowest coordinates in the entire model is 
designated as its Start Joint (or i-end). Consequently, the other end is the member End 
Joint (or j-end).
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5.2.4 Joint and Member Generation

In a plane (level or elevation), a pattern or a layout of joints and members may be repeated more 
than once. If you draw the typical layout, you can generate the others using Plane’s Copy or 
Extrude command. Copy is basically a limited version of Extrude and it allows in-plane 
generation only. Extrude allows in-plane and out-of plane generation.

5.2.4.1 (a) Selecting items to be generated

You must select the joints and members to be copied. Joints at selected member ends are 
automatically selected and may not be excluded from the selection. Selected joints and members 
will be referred to hereafter as selected items.

5.2.4.2 (b) Base joint

After making a selection, a base joint must be picked. This joint must be a selected joint. The 
generation distance is measured between base joints of successive copies and rotation is done 
about an axis at the base joint.

5.2.4.3 (c) Generation distance

The distance between the selected items and the first generated copy (and consequently, between 
any two consecutive generated copies) may be specified in rectangular or polar coordinates. 
Generation distance is measured between a base joint and the next generated base joint.

• For Rectangular coordinates, input the components of the distance (see Figure 5-3a and 
Figure 5-4a). Vertical and horizontal components are needed for the Copy command. X, 
Y, and Z components are needed for the Extrude command.

• For Polar coordinates, enter the radius and the angle that define the generation distance 
(see Figure 5-3b and Figure 5-4b). For the Copy command, the angle is always measured 
from the horizontal axis. For the Extrude command, two angles are needed, one from the 
X axis and the other from the Y axis.
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Figure 5-3 Generation distance for the Copy command

Figure 5-4 Generation distance for the Extrude command

5.2.4.4 (d) Rotation

Generated copies may be rotated about the axis orthogonal to the plane when using the Copy 
command. For the Extrude command, rotation may be specified about any of the three global axes. 
The right hand rule is used to determine the direction of the rotation (see Figure 5-5).

5.2.4.5 (e) Increment

An increment may be added to the generation distance to increase or decrease the distance 
between the successive generated items (see Figure 5-6). For example, four copies at a distance of 
10 ft and an increment of 5 ft will generate copies at 10, 15, 20, and 25 ft from each other, or at 10, 
25, 45, and 70 ft from the original base joint.

Similarly, an increment may be specified with the rotation angle with one difference, the rotation 
angle of all generated copies is always measured about the original base joint.
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Figure 5-5 Generation angle of rotation

For example, four copies with a rotation angle of 35° and an increment of 5° will generate copies 
at 35°, 40°, 45°, and 50°, all measured relative to the original position.

5.2.4.6 (f) Number of copies

This is the number of copies to be generated from the selected items.

5.2.4.7 (g) Connecting generated joints

When this option is selected, it instructs the program to create a member connecting any two 
corresponding joints of every successive copy (see Figure 5-7). A good example of when to use 
this option is while generating floor levels in a building structure. With this option ON, the 
columns between the levels are automatically created.
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Figure 5-6 Distance and rotation increment

Figure 5-7 Connecting generated joints

5.2.5 Generation by Mirroring

Another way of performing in-plane generation is by mirroring selected items. The mirror copy 
may be about a vertical (see Figure 5-8) or a horizontal (see Figure 5-9) reference line. Mirror 
copy is performed in-plane only.
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Figure 5-8 Mirroring about a vertical line - (a) before, (b) after

Figure 5-9 Mirroring about a horizontal line - (a) before, (b) after

5.3 Joint and Member Labels and Numbers

Joints and members are automatically numbered and labeled as they are drawn or generated on the 
basis of first-input, first-numbered. Labels are assigned as the joint or member number and may 
not be changed in spCad.

Since the user does not have control over the joint and member labels, spCad has a Relabel option. 
It instructs the program to relabel joints and members in a predetermined systematic manner. 
Notice though that this option affects labels only and not joint and member numbers.

5.3.1 Relabeling Joints

spCad searches for the joint with the lowest X, Y, Z coordinates in the entire model, and assigns 
label "1" to it. The program then increments the label by 1 and assigns it to the next joint moving 
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in the positive X direction first, the positive Z direction second, and finally in the positive Y 
direction, until all joints are labeled (see Figure 5-10a).

5.3.2 Relabeling Members

• Start with the XZ plane with the lowest Y coordinate (plane Y0 in Figure 5-10b)

• In plane Y0, start with the members that are parallel to the X-axis (X-beams).

• Label "1" is assigned to the beam with the lowest (X, Z) coordinates for its start joint.

Figure 5-10 Relabeling joints and members

• Moving in the positive X direction first, then in the positive Z direction second, member 
labels are incremented by 1 until all the X-beams on plane Y0 are relabeled (see Figure 5-
10c)

• Similar to the previous two steps, the Z beams are relabeled next, moving in the positive Z 
direction first, and then in the positive X direction until all the Z-beams on plane Y0 are 
relabeled (see Figure 5-10d)

• Moving up the positive Y axis to the next plane, the three preceding steps are repeated 
until all the X beams and Z beams on all the XZ planes are relabeled.

• Members parallel to the Y axis (columns) are relabeled next, starting at the bottom of the 
model and moving in the positive X direction first, the positive Z direction second, and in 
the positive Y direction last (see Figure 5-10e).

• Finally, diagonal members are done in a manner similar to the previous step
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5.4 Assign Member and Joint Properties

Joint and member properties (fixities, sections, materials, loads, etc.) are applied graphically in the 
Main window using the Assign menu commands. Selecting any of the Assign menu commands 
displays a modeless dialog box from which the property to assign may be chosen.

Using the left-mouse button, marquee select the joints or members to which the chosen property 
should be applied. To remove a property from a joint or member, the same procedure is done using 
the right-mouse button. With the exception of member loads, changing a member or joint property 
is done by assigning a different one.

5.4.1 Rotating, Zooming, and Translating while Assigning

While in the Assign mode, the mouse action is reserved to select or deselect joints and members. 
However, you may still zoom, rotate, or translate the graphical image without selecting the 
corresponding commands from the Show menu.

5.4.1.1 Using the mouse

By pressing and holding down a special key or key combination, the mouse action switches to 
Zoom, Rotate, or Translate.

5.4.1.2 Using the keyboard

The keyboard assignments for the Zoom, Rotate, and Translate commands are always active. 
These assignments are

Key to hold Mouse action

SHIFT Zoom

CTRL Rotate

SHIFT+CTRL Translate

Key to hold Action

CTRL+PGUP Zoom in

CTRL+PGDN Zoom out

Arrow keys Rotate

CTRL+Arrow key Translate
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5.5 Lateral Loads

spCad computes the equivalent static lateral loads (wind or seismic) on a building structure based 
on the 1991 version of the Uniform Building Code (UBC) and 1990 version of the National 
Building Code of Canada (NBC). NBC is available if the Metric system of units is selected, and 
UBC is available with the English system of units.

• The program assumes that the modeled structure is a building structure and the XZ planes 
are the floor levels.

• Each floor width, depth, and weight are computed based on the input geometry and 
assigned properties. The floor width is the projected dimension along the X axis while the 
depth is the projected dimension along the Z axis (see Figure 5-11). Floor weight is the 
weight of all members contained in the plane of the floor level plus the weights of the 
columns tributary to the floor level. Any panel loads assigned under the SELF load case 
will also be included in the floor weight.

• Floor dimensions may be increased to account for column dimensions, slab overhang, or 
exterior wall. Similarly, floor weight to be considered may be increased. Floor dimensions 
and weight may not be less than the computed values.

• Ybot, is the distance from the origin to the Ground elevation. The Ground elevation is the 
elevation below which no lateral loads will be applied to the floors. By default, Ground 
elevation is taken as the elevation of the lowest plane (see Figure 5-12 and Figure 5-13).

• The elevation of the top floor is taken as the Top Elevation by default. Top elevation may 
be increased to account for roof parapets. In this case, wind pressure will be applied over 
the area of the additional elevation, and the additional force will be added to the top level 
(see Figure 5-12).

• Wind pressure is applied to the face of the structure and is converted to concentrated 
lateral loads applied to each floor level based on the floor width (or depth, depending on 
the direction) and tributary height. Variation of wind pressure between floors is taken into 
account. The concentrated lateral load is applied at the center of the projected width or 
depth. An eccentricity with respect to the original line of action of the load can be 
specified (Figure 5-11a).
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Figure 5-11 Floor dimensions and lateral load point of application

• The total base shear due to seismic loads is distributed to the floor levels per the selected 
code. The floor seismic load is applied at the floor center of mass. An eccentricity with 
respect to the center of mass may be specified (Figure 5-11b).

• When the lateral forces (wind or seismic) are applied to the floors, each floor force is 
distributed to the floor joints. The force distribution takes into account any load 
eccentricities. The distribution of the floor force to the joints assumes that the modeled 
structure is a building structure and that the floor has a rigid diaphragm that distributes the 
force from the point of application to the joints. Only the joint loads are saved with the 
data file.
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Figure 5-12 Ground and Top elevations for wind loads

Figure 5-13 Ground elevation for seismic loads

5.6 Surface Loads

Surface Loads option of spCad enables you to draw panels spanning over members of a floor and 
apply area loads to these panels. Working in a specific floor plan (XZ plane), the panels are drawn 
graphically on the screen. A panel is a slab-like element that is attached to the members it comes 
in contact with.

• A panel is drawn by drawing panel nodes that are connected with straight lines to form the 
panel boundaries. The shape or size of a panel may be modified by moving, editing, or 
deleting some of its nodes.

• Openings may exist within a panel.

• By default, each member that comes in contact with a panel is attached to it. A member 
may be detached from a panel to exclude the panel load on it. A member that does not 
touch the panel cannot be attached to it.

• Panels are loaded with one uniform area load under a particular load case. The area load is 
applied over the entire panel.
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• Only gravity loads (including self weight) may be applied on a panel. The computed 
member loads are applied in the negative global Y direction.

• Each panel is divided into a grid of finite square elements. The area of each finite element 
is computed and assigned to the member closest to it. The total area of the segments 
assigned to a member constitutes its tributary area.

• The member load length is the member intersection with the panel. If the panel covers a 
member completely, the member load length is the entire length of the member.

• The tributary area of a member multiplied by the panel load is applied uniformly over the 
member. No variation of the load intensity is accounted for.

• Based on the member tributary area, a live load reduction can be computed. Load 
reduction may be computed for beams and columns. The load reduction factors are saved 
with the data file to be used by spFrame when combining the analysis results.

5.7 Working with Graphics

Drawing Grid

A grid may be superimposed over the Drawing area for guidance only. The pitch or step size 
of the drawing grid may be different in each direction, vertical or horizontal. The grid may be 
displayed in dotted, dashed, or solid lines in your choice of color. The grid limits (minimum 
and maximum) do not limit the area within which joints and members may be drawn.

Snap

Snapping is magnetizing the cursor position to predetermined locations on the screen. The 
most common snap setting is to grid intersections. The snap grid is an invisible grid of a 
constant pitch or step. As you move the cursor over the Drawing area, it snaps to the nearest 
snap grid intersection. If the snap step is equal to the drawing grid step, the cursor snaps to the 
drawing grid intersection.

Another way of snapping is object snapping. Snapping may be set to joint or midmember 
locations. When snapping is set to an object, a small square is shown at the object when the 
cursor snaps to it.

The snap accuracy is set to five pixels by default. Whenever the cursor is within five pixels of 
the snap object, it will snap to it. Snap accuracy may be changed using the SNAP dialog box.
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Precision

Cursor location is always displayed in the left cell of the Status bar. By default, cursor location 
is shown in whole numbers. To display more accurate cursor location (up to three numbers 
after the decimal), change the precision using the SNAP dialog box.

Preferences

By default, the Status bar displays the cursor location, the selected units for length, and the 
active plane coordinate. In addition, you may choose to display the drawing area limits 
(minimum and maximum in each direction), the grid status, snap status (snap grid step size and 
status), and the relative position. The latter is displayed when adding or moving joints or 
members. It gives the distance (vertical and horizontal components) and the angle from the 
horizontal axis of the current cursor location relative to the previous clicked-on location.

Other settings that may be specified in the PREFERENCES dialog box are the joints and 
member labels, the selection color (color of selected items), and the cursor shape. Cursor 
shape affects the cursor whenever within the Graphics area only.

5.8 spCad Window

Most windows have certain elements in common, such as a title bar and menus. Not all windows, 
however, have every element. To learn more about how to use window elements, refer to you 
Microsoft Windows manual.

In spCad, there are three different windows to work in. Main spCad window, which is the only 
active window when you first start the program, and two child windows, the Plane window and the 
Surface Loads window. Plane window opens when you choose the Plane command from the Main 
window’s Edit menu. Surface Loads window opens when you choose the Surface Loads command 
from the Main window’s Options menu. The following is a list of the different components of each 
window.

Control-Menu Box

Control-menu box is located in the upper-left corner of the window and includes commands 
for sizing, moving, enlarging, restoring, and closing the window, as well as switching to other 
applications. To access the Control-menu box using the mouse, click the left mouse button on 
the box; using the keyboard, press ALT + - (hyphen).

Minimize and Maximize Buttons

Minimize and Maximize buttons are located in the upper-right hand corner of the window. 
Minimize button (represented by a down arrow) shrinks the window to an icon. Maximize 
button (represented by an up arrow) enlarges the window so that it fills the entire desktop. 
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After you maximize the window, the Maximize button will be replaced by the Restore button 
(contains both an up and a down arrow); clicking on the Restore button returns the window to 
its previous size.

Title Bar

Title bar displays the name of the application along with the name of the current data file in 
use. If the data have not been saved into a file, the word Untitled is displayed in the Title bar.

Menu Bar

Menu bar is located directly below the Title bar. It lists the available menus. A menu contains 
a list of commands or actions you can execute.

Tool Bar

Tool bar is located on the left side of the window. It contains a collection of buttons (or icons) 
that provide a shortcut to accessing the menu commands. Tool bar buttons can only be 
accessed using the mouse. Tool bar also contains a graphical representation of the active axes 
indicating their positive directions.

Graphic Area

Graphics area covers most of the window. This is where the graphical editing and presentation 
is done.

Figure 5-14 spCad Window
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Status Bar

Status bar (Plane and Surface Loads windows only) is located directly below the Menu bar. It 
displays important information such as current units, cursor position, snap status, etc.

Message Bar

Message bar (Plane and Surface Loads windows only) is located along the bottom of the 
Graphics area. It displays instructions, hints, and helpful messages.

Using a Menu

To access a menu item using the mouse, point to the menu item and click the left-mouse 
button. Each menu item can also be selected with the keyboard by simultaneously pressing the 
ALT key and the underlined letter of the menu you want to open. For example, to open the File 
menu, press ALT + F.

To close a menu without selecting a command, point to any blank area on the screen and click 
the left-mouse button, or press ESC.

To choose a command from a selected menu, click the left mouse button on the command, or 
use the UP and DOWN ARROW keys until you reach the command and press ENTER.

5.9 Main Window Commands

Main window is the default window for the program. In this window you can perform file 
operations, print, create member properties and loads databases, assign member and joint 
properties and loads, view the entire structure, and access the Plane and Surface Loads windows.

5.10 File Menu

File menu is used for opening, saving, retrieving, and printing data files, and exiting the 
program. For a detailed description of the File menu commands, refer to Chapter 4 of the 
spFrame manual. 

New

Clears any input data and returns the data to the default values so that a new file may be 
started.

Open

Enables you to load an existing data file.
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Save

Saves the changes made to the current data file under that same filename. The new data 
overwrites the old data, and you cannot retrieve the old data. If a data file is untitled, the SAVE 
AS dialog box will appear.

Save As

Enables you to name or rename a data file. Use Save As to save both the original data and any 
changes currently made to the data. The original data remains under the old filename. If a file 
of the same name exists, the program will ask if you would like to overwrite the file.

Import

Imports an existing drawing created or edited using Auto CAD with a DXF file format.

Export

Saves the model geometry defined in the current data file to an AutoCAD file (with a DXF 
extension).

Revert

Used to discard any changes to the data and return to the version of data saved in the original 
data file. This option will only be available if the file has been modified since the last file save 
and the file has been saved prior to editing.

Print Data

Enables you to obtain a printout of the input data.

Print Screen

Enables you to print the graphical image displayed in the Graphics area of the spCad window.

Exit

Ends the spCad session and returns to the Program Manager. If any changes were made to the 
data and have not been saved, spCad will prompt you whether to save or abandon any changes 
made before you exit.

5.11 Access Menu

For a detailed description of the Access menu commands, see Chapter 4 of the spFrame 
manual. 
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Library

Creates new libraries or includes existing libraries in the current file for materials, sections, 
member loads, and non-prismatic members. 

Copy

Sends a copy of the graphical image displayed in the window to the Clipboard.

Settings

Enables you to change the settings for the angle of separation used while viewing the model in 
stereoscopic 3-D format.

Statistics

Provides information such as the structure type, number of joints, number of members, amount 
of memory used, and the amount of available memory and disk space

5.12 Define Menu

Define menu contains commands that are used to define the databases of the member 
properties and loads. For a detailed description of the Define menu commands, refer to 
Chapter 4 of the spFrame manual. 

Type 

Enables you to define the structure type (2- D or 3-D frame or truss), and input labels for the 
project and the engineer.

Units

Enables you to select a system of units to be used. Your choices are English or Metric. For the 
system that you choose, specify the units to be used with the different input and output 
parameters.

Defaults

Enables you to input the default values for the material and section properties. These default 
values will be assigned to members with no defined material or section properties.

Materials

Enables you to define new materials, or edit existing ones, and input their properties. A 
material entry consists of a label, density, modulus of elasticity, Poisson’s ratio, and thermal 
coefficient.
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Sections

Enables you to define new sections, or edit existing ones, and input their properties. A section 
entry consists of a label and, depending on the section type, section dimensions or properties.

Nonprismatic

Enables you to define new non-prismatic members, or edit existing ones, and input Main 
Window Commands the spCad Main Window 4-5 their properties. A nonprismatic member 
entry consists of a label, the stiffness factors at member ends, and the carry-over factor.

Member Loads

Enables you to define new loads to be applied as member loads, or edit existing ones. A load 
entry consists of a label, orientation, direction, type, intensity, and location.

Load Cases

Enables you to define the load cases under which the member loads, joint loads, and joint 
known displacements will be defined. Each load case should have a unique label.

Load Combinations

Enables you to factor the defined load cases and combine them into load combinations under 
which the structure will be analyzed.

5.13 Edit Menu

Edit menu contains commands that enable you to create or modify the model geometry. 

Plane

Opens the Plane window in which you may create new planes or edit existing ones. You may 
choose to work in the XY, XZ, or YZ plane. The plane editor enables you to draw and generate 
members and joints.

Joints

Enables you to modify, add, or delete joints in the Main window.

Add Member

Enables you to add a new member in the Main window.

Delete Member

Enables you to delete a member, or a group of members in the Main window.
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Undo Delete

Restores last deleted member.

5.14 Assign Menu

Assign menu contains commands that apply the various properties and loads to the defined 
joints and members. All assignments are done graphically. 

Supports

Enables you to assign supports by fixing the degrees of freedom of joints. Support inclination 
may also be specified.

Springs

Enables you to apply rotational and/or translational elastic supports at joints.

Member Types

Enables you to apply the material properties, section properties, and non-prismatic member 
properties (entered using the Define menu commands), along with the member orientation 
angle, to the members.

Refinement

Enables you to apply model refinement such as partial releases, shear corrections, and rigid-
end offsets to the members.

Member Loads

Enables you to apply the member loads (entered using the Define/Member Loads commands) 
to the members.

Joint Loads

Enables you to apply forces, moments, known displacements, and known rotations to the 
joints.

Self Loads

Enables you to select the members whose self weight should be included in the analysis under 
the SELF load case.

Rigid Diaphragms

Enables you to attach or detach horizontal members (beams) to a rigid diaphragm.
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Member Group

Enables you to group certain members together

5.15 Show Menu

Show menu options and commands enable you to manipulate the graphical display and control 
what is to be displayed in the Main window. For a detailed description of the Show menu 
commands, see Chapter 4 of the spFrame manual. 

Zoom

Enables you to magnify or reduce the graphical image displayed in the Graphics area.

Rotate

Enables you to rotate the graphical image displayed in the Graphics area about the X-axis or 
the Y-axis. By combining the rotation about the two axes, you will be able to view the structure 
from any angle.

Translate

Enables you to translate or move the graphical image displayed in the Graphics area.

Stereo

Toggles the Stereoscopic viewing mode ON or OFF.

Reset

Resets the graphical image to its original position, scale, and orientation.

Select

Enables you to select (tag) or deselect a portion of the structure to be made visible.

Hide/Show

Enables you to show or hide tagged members and joints.

Preferences

Enables you to specify what is to be displayed in the Graphics area. You can select from joint 
labels, member labels, supports, and member orientation. You may also select to show or hide 
beams and columns.
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Load Diagrams

Enables you to view the input loads superimposed on the model graphical image. You can also 
specify the magnification factor of the displayed loads.

Member Info

Displays a member information window over the Main window which contains important 
information about the members.

5.16 Options Menu

Save Settings

Enables you to save the defaults and settings of the current file to be used in future input 
sessions. 

Color

Enables you to modify color settings of the graphical image.

Autosave

An option that, if selected, causes the data to be saved periodically without selecting the Save 
command. You can also specify the Autosave time interval.

Surface Loads

Opens the Surface Loads window in which you may apply panels over horizontal members 
(beams) and assign surface loads (force per unit area) to those panels. The tributary areas and 
load distribution on the attached members will then be computed.

Load Reduction

Enables you to assign or compute the live load reduction factors to members.

Lateral Loads

Enables you to assign or compute lateral loads (wind or seismic) on the structure.

Relabel

An option that instructs the program to relabel (renumber) all members and joints in a 
systematic manner.
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5.17 Help Menu

Index

Lists all the available help topics. Click on any underlined topic and a help screen appears with 
the information about that item. 

About spCad

Displays a message box that gives copyright information, the version number of the spCad 
program, your firm name, city, and state.

Check for Updates

Checks if a newer version of the program is available. Internet connection is required.

5.18 Working in the Main Window

File, Access, Define, Show, and Help menu commands are similar to those of the spFrame 
program. For a detailed description of these menu commands, refer to your spFrame manual.

5.19 Working with Files

In spCad, files may be one of the following three formats

• spCad (*.FCD)—binary format that can be read by spCad only.

• spFrame (*.FRM)—binary format that can be read by 

• spCad and spFrame.

• ASCII (*.TXT)—text format that can be read by 

• spCad, spFrame, or any other text editor or word processor.

After creating a data file, it must be saved in spFrame (FRM) or ASCII text (TXT) format, so it 
may be opened by spFrame for analysis.

spCad can also read FRM and TXT files that were created using spFrame. Any analysis results 
contained in FRM files are ignored by spCad.

NOTE: spCad v1.5 can open FCD files created by PCA-Cad v1.0, however, area loads and 
associated load reduction factors are not read and have to be reentered. PCA-Cad v1.0 cannot read 
FCD files created by spCad v1.5.
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5.20 Create and Edit Planes

Creating the geometry of the structure is done using the Plane editor which displays your work in 
a planar (2-D) view. Plane editor is accessed via the Edit/Plane command.

• From the Edit menu, choose Plane. The dialog box of Figure 5-15 appears.

Figure 5-15 Plane dialog box

• Select the plane (or elevation) to work in, XY, XZ, or YZ.

• Choose the OK button.

Plane window is opened and the CHANGE PLANE dialog box is displayed. For more information 
on spCad Plane window and the Change Plane command refer to Chapter 5, spCad Plane Window.

5.21 Edit Joints

Joints and members are usually created and edited in the Plane window. However, you may 
perform quick editing of joints from the Main window.

• From the Edit menu, choose Joints. The modeless dialog box of Figure 5-16 appears. 
Some text boxes may not be available, depending on the structure type selected.

Figure 5-16 Joints dialog box
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• In the Graphics area, click on a joint. The joint label and its coordinates are displayed in 
the JOINTS box.

• To delete the selected joint, choose the DELETE button. Note that deleting a joint deletes 
all members attached to it.

• To modify the selected joint coordinates, edit their values in the text boxes and choose the 
MODIFY button.

• To add a new joint, enter its coordinates in the text boxes and choose ADD.

• Choose the CLOSE button to end joint editing.

5.22 Add and Delete Members

Members are usually generated in the Plane Window. There are cases, however, when you need to 
add or delete members from the Main Window.

5.22.1 To Add Members

• From the Edit menu, choose Add Member.

• In the Graphics area, point to a joint and click the left-mouse button.

• As you move the cursor, a line connecting the first joint to the cursor location appears. 
Point to another joint and click the left-mouse button. A member connecting the two joints 
is drawn.

• To add more members, repeat the two steps above.

• To end adding members, choose Edit/Add Member again, or choose another command.

5.22.2 To Delete Members

• From the Edit menu, choose Delete Member.

• In the Graphics area, point to the member you want to delete and click the left-mouse 
button.

• To delete a group of members, marquee select them. All members inside the marquee are 
deleted. Note that deleting members does not delete their end joints.

• To end deleting members, choose Edit/Delete Member again, or choose another 
command.

• If you delete a member by mistake, you can restore it by choosing Edit/Undo Delete.
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5.23 Assign Supports

From the Assign menu, choose Supports. Some options may not be available depending on the 
structure type selected. This box has two modes, ASSIGN and SHOW. To end supports 
assignment, choose the CLOSE button.

5.23.1 Assign Mode

• From the available check-box options, select the joint displacement or rotation to be fixed. 
If the joint is an inclined support, enter the inclination angle measured clockwise between 
the global coordinate axis and the rotated axis. This becomes the active assignment.

• Choose the ASSIGN button. All joints that share the active assignment are shown in red in 
the Graphics area. Joints with different assignments are shown in black and joints with no 
assignment are shown in green.

• In the Graphics area, using the left-mouse button, click on a single joint or marquee select 
a group of joints. To remove the assignment, do the same using the right-mouse button.

5.23.2 Show Mode

• Choose the SHOW button.

• In the Graphics area, click on a joint. All joints that have the same assignment as the 
selected joint are shown in red and the assignment is displayed in the SUPPORTS box.

5.24 Assign Spring Supports

From the Assign menu, choose Springs. The modeless dialog box of Figure 5-17 appears. Some 
options may not be available, depending on the structure type selected. This box has two modes, 
ASSIGN and SHOW. To end spring support assignment, choose the CLOSE button.
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Figure 5-17 Springs dialog box

5.24.1 Assign Mode

In the available text boxes, enter the translational and rotational spring constants for the active 
degrees of freedom. This becomes the active assignment.

• Choose the ASSIGN button. All joints that share the active assignment are shown in red in 
the Graphics area. Joints with different assignments are shown in black and joints with no 
assignment are shown in green.

• In the Graphics area, using the left-mouse button, click on a single joint or marquee select 
a group of joints. To remove the assignment, do the same using the right-mouse button.

5.24.2 Show Mode

• Choose the SHOW button.

• In the Graphics area, click on a joint. All joints that have the same assignment as the 
selected joint are shown in red and the assignment is displayed in the SPRINGS box.

5.25 Assign Member Properties

Material, section, and non-prismatic member properties are globally defined using the values 
entered using the Define/Defaults command. Members that do not have DEFAULT material, 
section, and non-prismatic properties can be assigned their different properties using the Assign/
Member Types command.

• From the Assign menu, choose Member Types. The modeless dialog box of Figure 5-18 
appears. To end member type assignment, choose the CLOSE button.
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Figure 5-18 Member Types dialog box

• From the drop-down list box, select the assignment type, MATERIALS, SECTIONS, and 
NONPRISMATIC. The list box displays the available entries of your selection. These 
entries were defined using the Define/Materials, Define/Sections, and Define/
Nonprismatic commands.

• From the list box, select the property to be applied. This becomes the active assignment. 
All members that share the active assignment are shown in red in the Graphics area. 
Members with different assignments are shown in black and members with the DEFAULT 
assignment are shown in green.

• In the Graphics area, using the left-mouse button, marquee select a member or a group of 
members. To remove the active assignment (apply DEFAULT), do the same using the 
right-mouse button.

• Repeat the three steps above for each type, Materials, Sections, and Nonprismatic.

• From the Assign menu, choose Refinement. The modeless dialog box of Figure 5-19 
appears. This box has two modes, ASSIGN and SHOW. To end refinement assignment, 
choose the CLOSE button.

   

Figure 5-19 Refinement dialog box
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• From the drop-down list, select the refinement to be assigned, RIGID-END OFFSETS, 
PARTIAL RELEASES, SHEAR CORRECTION, and ORIENTATION. The rest of the 
box displays text boxes that depend on your selection. Some text boxes may not be 
available, depending on the structure type.

Note: Member Start joint is the one closer to the joint with the lowest coordinates in the entire 
structure.

5.25.1 Assign Mode

• In the available text boxes, enter the information needed. This becomes the active 
assignment.

• Choose the ASSIGN button. All members that share the active assignment are shown in 
red in the Graphics area. Members with different assignments are shown in black and 
joints with no assignment are shown in green.

• In the Graphics area, using the left-mouse button, marquee select a member or a group of 
members. To remove the assignment, do the same using the right-mouse button.

5.25.2 Show Mode

• Choose the SHOW button.

• In the Graphics area, click on a member near its mid-length (if the Member Labels option 
is ON, click on the member label to select it). All members that have the same assignment 
as the selected member are shown in red and the assignment is displayed in the text boxes 
of the REFINEMENT box.

5.26 Apply Member Loads

• From the Assign menu, choose Member Loads. The modeless dialog box of Figure 5-20 
appears. To end member loads assignment, choose the CLOSE button.

Figure 5-20 Member Loads dialog box
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Note: Member Start joint is the one closer to the joint with the lowest coordinates in the entire 
structure.

• From the LOAD CASE drop-down list, select a load case under which the loads are to be 
applied to the members. The list box below displays the available loads that were defined 
using the Define/Member Loads command.

• From the list box, select the load to be applied. This becomes the active assignment. All 
members that share the active assignment are shown in red in the Graphics area. Members 
with a different assignment are shown in black and members with no assignment are 
shown in green.

• In the Graphics area, using the left-mouse button, marquee select a member or a group of 
members. To remove the active assignment, do the same using the right-mouse button.

5.27 Apply Joint Loads

• From the Assign menu, choose Joint Loads. The modeless dialog box of Figure 5-21 
appears.This box has two modes, ASSIGN and SHOW. To close the box and end joint 
loads assignment, choose the CLOSE button.

• From the LOAD CASE drop-down list, select a load case under which the loads are to be 
applied to the joints.

 

Figure 5-21 Joint Loads dialog box

• From the drop-down list, select the type of load to be assigned, FORCES & MOMENTS 
or DISPLACEMENTS & ROTATIONS. The rest of the box displays text boxes that 
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depend on your selection. Some text boxes may not be available, depending on the 
structure type.

5.27.1 Assign Mode

• In the available text boxes, enter the information needed. This becomes the active 
assignment.

• Choose the ASSIGN button. All joints that share the active assignment are shown in red in 
the Graphics area. Joints with different assignments are shown in black and joints with no 
assignment are shown in green.

• In the Graphics area, using the left-mouse button, marquee select a joint or a group of 
joints or simply click on a joint. To remove the assignment, do the same using the right-
mouse button.

5.27.2 Show Mode

• Choose the SHOW button.

• In the Graphics area, click on a joint. All joints that have the same assignment as the 
selected joint are shown in red and the assignment is displayed in the JOINT LOADS box.

5.28 Include Self Loads

By default, member self weight is not included in the applied loads. However, you may include the 
self weight of all or just selected members using the Assign/Self Loads command. The member 
self weight is automatically computed and included in the SELF load case.

• From the Assign menu, choose Self Loads.

• In the Graphics area, using the left-mouse button, marquee select the members whose self 
weight should be included. To remove members from the selection, marquee select them 
using the right-mouse button.

• To end self loads assignment, choose another command.

5.29 Rigid Diaphragms Assignment

• From the Assign menu, choose Rigid Diaphragms. The modeless dialog box of Figure 5-
22 appears. To end rigid diaphragm assignment, choose the CLOSE button.
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Figure 5-22 Rigid Diaphragm dialog box

• Choose the ATTACH ALL option button to attach all beams on all floors to rigid 
diaphragms.

• Choose the DETACH ALL option button to detach all beams on all floors from the rigid 
diaphragms.

5.29.1 To Attach or Detach Individual Members

• From the FLOOR drop-down list, select the level to work with.

• Choose the ASSIGN option button. Only the beams on the selected level will be affected 
by the assignment.

• In the Graphics area, using the left-mouse button, marquee select the member or members 
to attach to the diaphragm. To detach members from the diaphragm, do the same using the 
right-mouse button.

5.30 Group Members

• From the Assign menu, choose Member Group. The modeless dialog box of Figure 5-23 
appears. To end member group assignment, choose the CLOSE button.

Figure 5-23 Member Group dialog box
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5.30.1 Defining Member Groups

• In the LABEL text box, enter a group label.

• Specify whether the group should include beams only, columns only, or any member, by 
selecting the corresponding option.

• Specify whether the program should check to make sure that grouped members are of the 
same length or not by checking or clearing the CONFIRM LENGTH check-box option, 
respectively.

• Choose the ADD button. The group label is added to the drop-down list.

• Repeat the three steps above until all groups are defined.

5.30.2 Adding Members to a Defined Group

• From the drop-down box, select a group.

• In the Graphics area, using the left-mouse button, marquee select the members to be 
included in that group. To remove a member from a group, do the same using the right-
mouse button.

Note: It may happen that some members are selected to be grouped and only a few of them are 
shown in red. This indicates that the selected members do not have the same length (with the 
CONFIRM LENGTH option ON), or they are of different types (beams in a column group or vice 
versa).

5.31 Create and Edit Surface Loads

Working in the XZ plane (floor), panels may be drawn and surface loads (force per unit area) may 
be assigned to those panels. spCad computes the tributary area for each member attached to a 
panel, along with the equivalent member load. These member loads may then be added to the 
Member Loads definitions to be applied on the members.

• From the Options menu, choose Surface Loads. This command is not available if no 
planes and no load cases are defined.

Surface Loads window is opened and the CHANGE LEVEL dialog box is displayed. For more 
information on the Surface Loads window and the Change Level command refer to Working in the 
Surface Loads Window in Chapter 7.
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5.32 Apply Load Reduction

Based on the member tributary areas computed in the Surface Loads window, spCad computes a 
load reduction factor to be associated with a particular load case. Since the live load reduction of 
columns is a function of their cumulative tributary areas, this command should be selected after 
you assign and load panels on all the floors.

Figure 5-24 Load Reduction dialog box

• From the Options menu, choose Load Reduction. This command will be available only 
after inputting panels on the levels and distributing the loads to the attached members. The 
dialog box of Figure 5-24 appears.

• From the LOAD CASE drop down list, select the load case to be designated as a live load 
case.

• From the TYPE group, choose BEAMS or COLUMNS. The members of the selected type 
are displayed in the list box, along with the member tributary area.

• From the list box, select the members you want to assign a live load reduction to.

• From the REDUCTION drop-down list, select the method of reduction, or NONE for no 
reduction.

• Choose the ASSIGN button.

• Repeat the four steps above for the other type (beams or columns). Note that for columns, 
the program computes the cumulative tributary areas.

• Choose the OK button.
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5.33 Compute Lateral Loads

Lateral loads (wind or seismic) may automatically be computed by spCad using the Options/
Lateral Loads command. Since the equivalent static loads depend on the geometry of the 
structure, this option should be used after the entire structure is defined.

• From the Options menu, choose Lateral Loads. The dialog box of Figure 5-25 appears.

Figure 5-25 Lateral Loads dialog box

• UBC code is available for the English units system and NBC is available for the Metric 
system.

• From the LOAD CASE drop-down list, select the load case under which the lateral load 
should be included.

• From the LOAD TYPE group, select WIND or SEISMIC. 

• From the DIRECTION group, select the direction in which the load is applied.

• To input the code-related parameters, choose the PARAMETERS button. A dialog box 
that depends on the selected code and load type appears (see description on the following 
pages).

• To modify the computed floor weights or dimensions, choose the FLOOR DATA button. 
The dialog box in Figure 5-26 appears. In this box you may change the width, depth, or 
weight of a floor. Input values may not be less than computed values.

• After all data are input, the computed loads and their point of action are displayed in the 
list box. For seismic loads, the load point of application is the center of mass (Xm, Zm). 
For wind loads, it is the center of the floor projected dimension in each direction (Xf, Zf).
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• You may edit the forces or edit their location by specifying an eccentricity measured from 
the load point of application. To do so, select the item in the list box, edit the values in the 
text boxes, and choose the MODIFY button.

• To assign the loads to the floors, choose the APPLY LOADS button.

• To obtain a printout of the lateral loads, choose the PRINT button.

5.33.1 Floor Data

• In the GROUND ELEVATION text box, input the elevation of ground level from the 
origin in the Y direction (default value is the coordinate of the lowest XZ plane). Lateral 
loads will not be applied to the floors below the Ground Elevation.

• In the TOP ELEVATION text box, input the top of building elevation (if different than 
computed) from the origin in the Y direction. This is to account for parapets that may exist 
on the roof. The additional height will be considered in computing the wind load on the 
top floor. This value may not be less than the top floor elevation.

Figure 5-26 Floor Data dialog box

• To modify a floor data, select the level from the list box, edit its width, depth, or weight, 
and choose the MODIFY button. Input values may not be less than computed values.

• Choose the OK button. The forces in the lateral loads box are updated.

5.33.2 UBC Wind Parameters

• Enter the basic wind speed, v [Figure No. 23-1 of the Code].

• Enter the windward and leeward pressure coefficients, Cq.
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• The stagnation pressure, qs, is computed based on the input basic wind speed, v, [Table 
23-F of the Code] and displayed.

• From the EXPOSURE group, select an exposure, B, C, or D [Sec. 2312 of the Code].

• From the OCCUPANCY group, select an occupancy type, ESSENTIAL, HAZARDOUS, 
SPECIAL, or STANDARD. The importance factor, I, is computed [Table 23-L of the 
Code] and displayed. To input a different I value, select the I= option and enter its value. 
UBC 1991, Seismic Parameters.

• From the ZONE group, select the applicable seismic zone, 1, 2A, 2B, 3, or 4 [Figure 23-2 
of the Code]. The corresponding Z factor is displayed.

• From the SOIL TYPE group, select the applicable type, S1, S2, S3, or S4 [Table 23-J of 
the Code]. The site coefficient, S, is displayed. To input a different S value, select the S= 
option and enter its value.

• From the OCCUPANCY group, select an occupancy type, ESSENTIAL, HAZARDOUS, 
SPECIAL, or STANDARD. The importance factor, I, is computed [Table 23-L of the 
Code] and displayed. To input a different I value, select the I= option and input its value.

• From the STRUCTURE group, select the structure type, concrete momentresisting frame, 
steel moment resisting frame, or other [Sec. 2334(b)2A of the Code]. The Ct coefficient is 
displayed. To input a different Ct value, select the Ct= option and enter its value.

• From the LATERAL LOAD-RESISTING SYSTEM group, select a system type [Table 
23-O of the Code]. The Rw coefficient is displayed. To input a different Rw value, select 
the Rw= option and enter its value.

• Based on the selected options, the structural period is computed [Eq. (34-3) of the Code] 
and displayed. If different than that computed, enter the value of the period, T.

• The top level force, Ft, and the base shear, V, are computed [Sec. 2334(d) of the Code] and 
their ratios to the total weight, W, are displayed. These values may not be modified.
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Figure 5-27 UBC Wind Parameters

Figure 5-28 UBC Seismic Parameter

5.33.3 NBC Wind Parameters

• Enter the wind speed, v*.

• From the EXPOSURE group, select A, B, or C [NBC Supplement Commentary B].

• Enter the pressure coefficient, Cp, for the windward and the leeward surfaces [NBC 
Supplement, Commentary B].

• Based on the input wind speed, the wind pressure, q, is computed [NBC Supplement, 
Commentary B] and displayed. If different than computed, enter its value.

• Enter the gust factor, Cg [Sec. 4.1.8.1(6) of the Code].
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• The exposure factor for the leeward surface, Ce, is computed [NBC Supplement, 
Commentary B] and displayed. If different than computed, enter its value.

5.33.4 NBC Seismic Parameters

• Enter the acceleration-related seismic zone factor, Za*.

• Enter the velocity-related seismic zone factor, Zv*.

• Enter the zonal velocity ratio, v*.

• Enter the structural period, T.

• Based on the input Za, Zv, and T, the seismic response factor, S, is computed [Table 
4.1.9.A of the Code] and displayed. If different than computed, enter its value.

• Enter the force modification factor, R [Table 4.1.9.B of the Code].

• From the IMPORTANCE group, select the appropriate category. The importance factor, I, 
is displayed [Table 4.1.9.1(10) of the Code]. To input a different I value, select the I= 
option and enter its value.

• From the FOUNDATION group, select the appropriate type. The foundation factor, F, is 
displayed [Table 4.1.9.C of the Code]. To input a different F value, select the F= option 
and enter its value.

• *"Design Data for Selected Locations in Canada", Chapter 1, NBC Supplement.

• The top level, Ft, and the minimum lateral seismic force, V, are computed and their ratios 
to the total weight are displayed. These values may not be modified

Figure 5-29 NBC Wind Parameters
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Figure 5-30 NBC Seismic Parameters

5.34 Relabel Joints and Members

Joints and members are labeled and numbered internally on the basis of first-input first-labeled. To 
relabel joints and members in an orderly manner, use the Options/Relabel command.

• From the Options menu, choose Relabel. A confirmation dialog box appears.

• Choose the YES button to relabel. Relabeling is done in a predetermined manner. See the 
Relabel option in Chapter 3 for more information.

Figure 5-31 Relabel dialog box
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6.1 Plane Window Commands

Plane window is opened when you choose the Edit/Plane command in the Main spCad window. 
Plane is a planar (2-D) graphics editor in which you can create and edit joints and members in any 
of three planes or elevations (XZ, YZ, or XY). Planes can then be copied multiple times, with any 
offset or rotation, to model the entire structure.

6.2 Options Menu

Change Plane

Enables you to choose a new plane to work in. You may also add 
new planes, delete, or modify existing planes. 

Drawing Area

Enables you to set the limits and grid size for your plane drawing 
area.

Snap

Enables you to specify different snap settings to suit your drawing needs.

Print Screen

Enables you to obtain a printout of the image displayed in the Graphics area of the Plane 
Window.

Exit

Accepts the changes made in the Plane editor, closes the Plane window, and returns control to 
the Main CAD window.
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6.3 Edit Menu

Add Joint

Enables you to add joints graphically. 

Delete Joint

Enables you to delete joints graphically.

Move Joint

Enables you to graphically move a joint to a different location.

Edit Joint

Enables you to add, delete, or modify a joint from a dialog box.

Add Member

Enables you to add members graphically.

Delete Member

Enables you to delete members graphically.

Move Member

Enables you to graphically move a member to a different location.

Circle

Allows you to graphically draw members along the circumference of a circle.

6.4 Duplicate Menu

Select

Selects the members to be affected by one of the four duplication 
procedures under the Duplicate menu. 

Copy

Copies the selected members, in-plane, with any specified offset and/or 
rotation.

Extrude

Copies the selected members, out-of-plane, with any specified offset and/or rotation.
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Mirror H

Creates a mirror image of the selected members about a horizontal line.

Mirror V

Creates a mirror image of the selected members about a vertical line.

Undo

Undo any duplication performed.

6.5 Show Menu

Show menu options and commands enable you to manipulate the 
graphical display and control what is to be displayed in the Plane 
window. 

Zoom

Enables you to magnify or reduce the graphical image displayed in 
the Graphics area.

Translate

Enables you to translate or move the graphical image displayed in the Graphics area.

Reset

Resets the graphical image to its original position and scale.

Redraw

Refreshes the window and redraws the image.

Preferences

Enables you to specify what is to be displayed in the Graphics area.

Superimpose

Enables you to view multiple levels or planes superimposed on the current plane.

6.6 Working in the Plane Window

Show menu commands of the Plane window are similar to the Show menu commands of the Main 
window. Also, refer to Working With Graphics in Chapter 2 for additional information.
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6.7 Change Plane

Allows you to switch to other planes for editing, deleting, or modifying existing planes, or 
creating new ones.

• From the Options menu, choose Change Plane. The dialog box of Figure 6-1 appears.

Figure 6-1 Change Plane dialog box

6.7.1 To Create a New Plane

• In the LABEL text box, enter the plane label.

• In the COORD text box, enter the orthogonal distance from the origin (when working with 
a building structure, for the XZ plane, typically this would be the floor elevation).

• Choose the ADD button. The data entered are added to the list box at the bottom.

6.7.2 To Start Drawing in a Plane

• From the list box, select the plane to work in.

• Choose the OK button. The selected plane becomes the active plane and its joints and 
members (if any exist) are displayed in the Graphics area of the Plane window.

6.7.3 To Modify a Plane Label or Coordinate

• From the list box, select the plane to edit.

• Change the label or the plane coordinate in the corresponding text boxes. A plane 
coordinate must be between the coordinates of the two planes immediately before and 
after it.

• Choose the MODIFY button. The data in the list box are changed.
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6.7.4 To Delete a Plane

• From the list box at the bottom, select the plane to delete.

• Choose the DELETE button.

Note that deleting a plane deletes all joints within the plane along with all members attached to 
those joints. Planes with no joints will automatically be deleted.

6.8 Drawing Area

• From the Options menu, choose Drawing Area. The dialog box of Figure 6-2 appears.

• In the text boxes of the LIMITS group, enter the limits of the drawing.

• In the GRID group, enter the grid step size in each direction.

• Specify whether the grid should be visible or not by selecting or clearing the SHOW 
GRID check-box option. With this option ON, a grid with the specified step size will be 
placed over the entire drawing area. Note that the grid is used for guidance and clarity and 
does not affect the drawing capabilities.

• Select a grid line type, DOT, DASH, or SOLID; and a grid line color from the COLOR 
list.

• Choose the OK button.

Figure 6-2 Drawing Area dialog box

• From the Options menu, choose Snap. The dialog box of Figure 6-3 appears.



spCad PLANE WINDOW

| 188 |

Figure 6-3 Snap dialog box

• In the corresponding text boxes, input the coordinates of the snap grid. A snap grid is a 
magnetized grid of constant pitch (horizontal and vertical may be different) to which the 
cursor is attached.

• Select the SNAP ON check-box option to turn snapping to the snap grid ON, or clear it to 
turn the snap OFF.

• From the PRECISION drop-down list, select a precision setting. This controls the 
accuracy of the cursor location.

• In the ACCURACY text box, specify the range (in pixels) within which the proximity of a 
snap location is affected.

• In the OBJECT group, specify whether to snap to a joint or mid-member, by selecting the 
corresponding check-box option.

• Choose the OK button.

6.9 Working with Joints

6.9.1 Adding Joints

• From the Edit menu, choose Add Joint.

• In the Graphics area, point to the desired location and click the left-mouse button. Note 
that the coordinates of the cursor location are shown in the Status bar.

• To end adding joints, choose another command.

6.9.2 Deleting Joints

• From the Edit menu, choose Delete Joint.
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• To delete a joint, point to it and click the left-mouse button. To quickly select a joint, turn 
the JOINT option ON in the SNAP dialog box. A selected joint has a small rectangle 
around it.

• To delete a group of joints, marquee select them. All joints inside the marquee are deleted. 
Note that deleting a joint deletes all members connected to it.

• To end deleting joints, choose another command.

6.9.3 Moving Joints

• From the Edit menu, choose Move Joint.

• In the Graphics area, point to a joint and marquee select. A dotted line connecting the 
original joint location and the cursor location appears. When the joint is over the new 
desired location, release the mouse button. The joint is moved to the new location. Any 
members connected to the joint will move with it.

• To end moving joints, choose another command.

6.9.4 Editing Joints

• From the Edit menu, choose Edit Joint. The modeless dialog box of Figure

Figure 6-4 Edit Joint dialog box

• In the Graphics area, point to a joint and click the left-mouse button. The joint number in 
the list box is highlighted and its coordinates are displayed in the corresponding text 
boxes. In the list box, LOCAL represents the joint number in the active plane and 
GLOBAL represents its number in the whole structure. LOCAL and GLOBAL values 
cannot be edited.

• To move the joint, edit its coordinates and choose the MODIFY button.

• To delete the joint, choose the DELETE button. Deleting a joint deletes all members 
connected to it.
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• To add a new joint, type its coordinates in the text boxes and choose the ADD button.

• To end joint editing, choose the CLOSE button.

6.10 Working with Members

6.10.1 Adding Members

• From the Edit menu, choose Add Member.

• Click the left-mouse button on the location of one member end. As you move the cursor, a 
line representing the member follows. To anchor the member, click on the location of its 
other end. By doing so, another member is started.

• Joints are automatically created at member ends and members are automatically numbered 
as entered.

• To start a member at a different location or to end adding members, click the right-mouse 
button.

6.10.2 Deleting Members

• From the Edit menu, choose Delete Member.

• To delete a member, click on the member near its mid-length. To quickly select a member, 
turn the MID-MEMBER option ON in the SNAP dialog box. A selected member has a 
small rectangle near its mid-length.

• To delete a group of members, marquee select them. All members inside the marquee are 
deleted. Note that deleting a member does not delete its end joints.

• To end deleting members, choose another command. 

6.10.3 Moving Members

• From the Edit menu, choose Move Member.

• In the Graphics area, point to a member near its mid-length, click and hold the left-mouse 
button, and drag the cursor to another location. A dotted line representing the new member 
location appears. When the member is at the desired location, release the mouse button. 
Note that moving a member does not move its end joints, but rather, creates two new 
joints.

• To end moving members, choose another command.
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6.10.4 Members on a Circle

Edit/Circle command enables you to draw members that, when connected, form the 
circumference of a circle.

• From the Edit menu, choose Circle.

• In the Graphics area, point to the location of the circle center and click the left-mouse 
button. The dialog box in Figure 6-5 appears.

Figure 6-5 Circle dialog box

• Modify the circle center coordinates, if needed, and enter its radius in the corresponding 
text boxes.

• In the SEGMENTS text box, enter the number of line segments around the circle 
circumference.

• Choose the OK button. The specified number of members along the circle are drawn.

6.10.5 Selecting Items for Duplication

Duplicate/Copy command allows you to make multiple in-plane copies of selected members and 
joints. The distance between a designated base joint and the generated copy of that base joint, in 
rectangular or polar coordinates, must be specified. Rotation while copying is possible, as well as 
varying increments for multiple copies.
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• From the Duplicate menu, choose Copy. If you have not selected members and joints to 
be copied you are prompted to do so.

• In the Graphics area, using the left-mouse button, click on a base joint. The base joint must 
be a selected joint. The dialog box of Figure 6-6 appears.

Figure 6-6 Copy dialog box

• Select a copy type, RECTANGULAR or POLAR.

• For a RECTANGULAR copy, enter the horizontal and vertical components of the distance 
between the base joints of any two consecutive generated copies and the rotation angle 
(about the orthogonal out-of-plane axis), along with their respective increments.

• For a POLAR copy, enter the radius, angle, and the rotation angle, along with their 
respective increments, in the corresponding text boxes.

• In the QUANTITY text box, enter the number of copies to be generated. This number 
must be less than 99.

• Select or clear the CONNECT JOINTS option. With this option selected, generated joints 
of consecutive copies will be connected by members.

• In the COMMON ZONE text box, enter the distance within which any two joints will be 
considered one.

• Choose the OK button.

• The specified in-plane copies of the selected items are generated. To undo the generation, 
choose the Duplicate/Undo command.
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6.11 Generation by Copy

Duplicate/Copy command allows you to make multiple in-plane copies of selected members and 
joints. The distance between a designated base joint and the generated copy of that base joint, in 
rectangular or polar coordinates, must be specified. Rotation while copying is possible, as well as 
varying increments for multiple copies.

• From the Duplicate menu, choose Copy. If you have not selected members and joints to 
be copied you are prompted to do so.

• In the Graphics area, using the left-mouse button, click on a base joint. The base joint must 
be a selected joint. The dialog box of Figure 6-6 appears.

Figure 6-7 Copy dialog box

• Select a copy type, RECTANGULAR or POLAR.

• For a RECTANGULAR copy, enter the horizontal and vertical components of the distance 
between the base joints of any two consecutive generated copies and the rotation angle 
(about the orthogonal out-of-plane axis), along with their respective increments.

• For a POLAR copy, enter the radius, angle, and the rotation angle, along with their 
respective increments, in the corresponding text boxes.

• In the QUANTITY text box, enter the number of copies to be generated. This number 
must be less than 99.

• Select or clear the CONNECT JOINTS option. With this option selected, generated joints 
of consecutive copies will be connected by members.

• In the COMMON ZONE text box, enter the distance within which any two joints will be 
considered one.
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• Choose the OK button.

• The specified in-plane copies of the selected items are generated. To undo the generation, 
choose the Duplicate/Undo command.

6.12 Generation by Extrude

Duplicate/Extrude command allows you to make multiple in- and out-of-plane copies of selected 
members and joints. Extrusion may be specified with varying increments and rotations.

• From the Duplicate menu, choose Extrude. If you have not selected members and joints 
to be extruded, you will be prompted to do so.

• In the Graphics area, using the left-mouse button, click on a base joint. The base joint must 
be a selected joint. The dialog box of Figure 6-7 appears.

Figure 6-8 Extrude dialog box

• Select an extrusion type, RECTANGULAR or POLAR.

• For a RECTANGULAR extrusion, enter the X, Y, and Z components of the distance 
between the base joints of any two consecutive generated copies and the rotation about the 
global axes, along with their respective increments.

• For a POLAR copy, enter the radius, angle, and the rotation angle of the base joint, along 
with their respective increments.

• In the QUANTITY text box, enter the number of copies to be generated. This number 
must be less than 99.

• In the COMMON ZONE text box, enter the distance within which any two joints will be 
considered one.

• Select or clear the CONNECT GENERATED JOINT option. With this option selected, 
generated joints of consecutive copies will be connected by members.

• Choose the OK button.
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The specified copies of the selected items are generated. To undo the generation, choose the 
Duplicate/Undo command.

6.13 Generation by Mirror

6.13.1 Mirror H

Duplicate/Mirror H command allows you to create a mirror image of selected members and 
joints about a horizontal line.

• From the Duplicate menu, choose Mirror H. If you have not selected members and 
joints, you will be prompted to do so.

• In the Graphics area, click and hold down the left-mouse button. A horizontal line appears. 
As you drag the mouse, the horizontal line moves with the cursor. When the line is at the 
desired location, release the mouse button. A mirror image of the selected items about the 
line is created.

• To cancel the command, click the right-mouse button while holding down the left-mouse 
button, then release the left button.

• To undo the changes, choose the Duplicate/Undo command. 

6.13.2 Mirror V

Duplicate/Mirror V command allows you to create a mirror image of selected members and 
joints about a vertical line.

• From the Duplicate menu, choose Mirror V. If you have not selected members and joints, 
you will be prompted to do so.

• In the Graphics area, click on a location and hold down the left-mouse button. A vertical 
line appears. As you drag the mouse, the vertical line moves with the cursor. When the line 
is at the desired location, release the mouse button. A mirror image of the selected items 
about the line is created.

• To cancel the command, click the right-mouse button while holding down the left-mouse 
button, then release the left button.

• To undo the changes, choose the Duplicate/Undo command.
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6.14 Superimpose

Show/Superimpose command allows you to superimpose another plane over the active plane for 
comparison and verification purposes only.

• From the Show menu, choose Superimpose. The dialog box of Figure 6-8 appears.

Figure 6-9 Superimpose dialog box

• From the PLANES drop-down list, select a plane.

• Choose the OK button.

• The members and joints of the selected plane are superimposed over the active plane and 
are shown in different color. Note that the superimposed planes may not be edited. To 
remove the superimposed plane, choose the command again and select NONE from the 
PLANE drop-down list.
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7.1 Surface Loads Window Commands

Surface Loads window is opened when you choose the Options/Surface Loads command from 
the Main spFrame window. Like the Plane window, it is a planar (2- D) graphics editor. It enables 
you to draw panels spanning over members of a plane (floor) and apply area loads to those panels.

7.2 Options Menu

Change Level

Enables you to choose a new level to work in. 

Drawing Area

Enables you to set the limits and grid size for your plane drawing area.

Snap

Enables you to specify different snap settings to suit your drawing needs.

Copy To

Copies the panels and loads on the current level to other levels.

Print Screen

Enables you to obtain a printout of the image displayed in the Graphics area of the Surface 
Loads Window.

Exit

Accepts the changes made in the Surface Loads window, closes the Surface Loads window, 
and returns control to the Main window.

7.3 Edit Menu

Add Panel

Enables you to add a panel at any location. 

Add Opening

Enables you to add an opening within a panel.
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Add Node

Enables you to add a panel node.

Delete Node

Enables you to delete a panel node.

Move Node

Enables you to move a panel node to a different location.

Edit Node

Enables you to add, edit, or delete a panel node.

Select Panel

Enables you to select a panel to load.

Select Member

Enables you to select (or deselect) the members to be attached to (or detached from) a panel.

Load Panel

Enables you to apply a uniform load over the selected panel.

Distribute

Enables you to compute the tributary areas of the members attached to the selected panel and 
distribute the panel load to those members accordingly.

7.4 Show Menu

Show menu options and commands enable you to manipulate the graphical display and control 
what is to be displayed in the Surface Loads window. 

Zoom

Enables you to magnify or reduce the graphical image displayed in the Graphics area.

Translate

Enables you to translate or move the graphical image displayed in the Graphics area.

Redraw

Refreshes the window and redraws the image.
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Reset

Reset graphical image to its original position and scale.

Preferences

Enables you to specify what is to be displayed in the Graphics area.

7.5 Working in the Surface Loads Window

Since the Surface Loads window commands are similar to the Plane window commands, (such as 
Change Level, Drawing Area, Snap, etc.), refer to Chapter 6 for a detailed description of these 
commands. 

7.6 Copy Panels to Other Levels

Options/Copy To command allows you to copy panels and panel loads from the active plane 
(level) to other planes (levels).

• From the Options menu, choose Copy To. The dialog box of Figure 7-1 appears.

Figure 7-1 Copy To dialog box

• From the list box, select the plane to copy the panels and loads to.

• Choose the OK button. All panels and panel loads are copied to the specified planes.
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7.7 Add Panels and Openings

7.7.1 Adding Panels

Edit/Add Panel command allows you to draw solid panels that span over members. Drawing a 
panel is done by drawing panel nodes that will be connected by lines that form the panel boundary.

• From the Edit menu, choose Add Panel.

• In the Graphics area, point to a location and click the left-mouse button. A panel node will 
be inserted. As you move the cursor, a line stretching from that node follows it. Click on 
another location to add another panel node,

•  anchor the line, and start another one. Repeat until the entire panel is defined.

• To end drawing a panel and start another one, click the right-mouse button. The panel area 
will be shaded.

• Repeat the steps above to define more panels. As you add more panels, the active panel 
will be shaded in red while all other panels are shaded in black.

7.7.2 Adding Openings

Edit/Add Opening command allows you to define an opening within a panel. An opening must 
be confined to a panel and multiple openings are allowed within a panel. Once you start drawing 
the opening, you may not extend it outside the panel borders.

• From the Edit menu, choose Add Opening.

• In the Graphics area, point to a location within a panel and click the leftmouse button. An 
opening node will be inserted. As you move the cursor, a line stretching from that node 
follows it. Click on another location to add another opening node. Repeat until the entire 
opening is defined.

• To end drawing an opening and start another one, click the right-mouse button. The 
shaded portion of the panel that is defined as an opening is cleared to represent the 
opening.

7.8 Edit Panels and Openings

A panel (or opening) consists of a group of nodes at the corners connected by straight lines that 
form the panel edges. Editing panel nodes enables you to modify the shape of the panel.
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7.8.1 Adding Panel Nodes

Edit/Add Node command enables you to add panel or opening nodes. Nodes that are added using 
this command are restricted to panel or opening borders (perimeters).

• From the Edit menu, choose Add Node.

• In the Graphics area, point to the location where you want to insert a node and click the 
left-mouse button.

• To end adding nodes, choose another command.

7.8.2 Deleting Panel Nodes

• From the Edit menu, choose Delete Node.

• To delete a node, point to it and click the left-mouse button. A selected node has a small 
rectangle around it.

• To delete a group of nodes, marquee select them. All nodes inside the marquee are deleted.

• To end deleting nodes, choose another command.

7.8.3 Moving Panel Nodes

• From the Edit menu, choose Move Node.

• In the Graphics area, point to a node, click and hold the left-mouse button, and drag the 
cursor to another location. The shape of the panel attached to the node is drawn as you 
move the cursor. When the node is at the new desired location, release the mouse button.

• To end moving nodes, choose another command.

7.8.4 Editing Panel Nodes

• From the Edit menu, choose Edit Node. The model’s dialog box of Figure 7-2 appears.
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Figure 7-2 Edit Node dialog box

• In the Graphics area, point to a node and click the left-mouse button. The node number in 
the list box is highlighted and its coordinates are displayed in the corresponding text 
boxes.

• To edit the node, modify its coordinates and choose the MODIFY button.

• To delete the node, choose the DELETE button.

• To add a new node, type its coordinates in the text boxes and choose the ADD button.

• To end node editing, choose the CLOSE button.

7.9 Attach Members to Panel 

By default, all members that are in contact with a panel are attached to it. You may, however, want 
to detach some members from a panel. To do so, you must first select the panel to work with using 
the Edit/Select Panel command, and, second, attach or detach its members using the Edit/Select 
Member command.

7.9.1 Select Panel

Edit/Select Panel command allows you to select the panel to attach or detach members to or apply 
loads over it.

• From the Edit menu, choose Select Panel.

• In the Graphics area, point anywhere within the panel you want selected and click the left-
mouse button. A selected panel becomes the active panel and is shaded red. All other 
panels are shaded black.
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7.9.2 Select Member

Edit/Select Member command allows you to specify which members are to be attached to the 
active panel. It also allows you to detach members from the active panel.

• From the Edit menu, choose Select Member.

• To detach (remove) a member from a panel, marquee select the member using the right-
mouse button.

• To attach a member to the active panel, select the member using the leftmouse button. 
Only members that touch the panel may be attached to it.

7.10 Load Panels

Edit/Load Panel command allows you to assign an area load (force per area) to the active panel 
(selected using Edit/Select Panel). This load will be distributed to all members attached to the 
panel.

• From the Edit menu, choose Load Panel. The dialog box of Figure 7-3 appears. The list 
box at the bottom shows all load cases and the panel load for each.

Figure 7-3 Load Panel dialog box

• From the list box, select the load case under which the panel load should be applied.

• In the INTENSITY text box, input the value of the load. This load is applied in the 
negative direction of the global Y axis.

• Choose the MODIFY button. The data in the list box are updated.

• Repeat the three steps above for each load case.

• Choose the OK button.
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7.11 Distribute Panel Loads to Members

Edit/Distribute command computes the tributary areas of the members attached to the active 
panel and distributes the area loads assigned to the active panel to these members. It also allows 
you to modify the loads and their location, add the loads to the member loads definitions, and 
apply the computed loads to the members.

• From the Edit menu, choose Distribute. The dialog box of Figure 7-4 appears.

• The computed area of the active panel is shown. The list box lists the members attached to 
the active panel, the ratio of the member tributary area to the total area (in percentage), 
and the member tributary area. These values are computed based on the panel and may not 
be modified.

• Choose the SHOW LOADS button. The dialog box of Figure 6-5 appears.

• From the LOAD CASE drop-down list, select a load case. The list box displays the panel 
members and the computed load data.

Figure 7-4 Distribute dialog box

7.11.1 To Edit a Member Load

• From the list box, select a member. Its assigned load label, computed load value, and 
location, are displayed in the corresponding text boxes.
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Figure 7-5 Show Loads dialog box

• Edit the load label, its magnitude, start location ratio, or length ratio, in the corresponding 
text box.

• Choose the MODIFY button. The data in the list box are updated.

7.11.2 To Add a Load to the Member Loads Definitions

• From the list box, select the load to be added.

• Choose the ADD TO LOADS button. The load will be added to the Member Loads 
definitions (as if it was entered using the Define/Member Loads command in the Main 
window).

7.11.3 To Assign All Loads to Members

• Choose the APPLY ALL button. All computed member loads will be added to the 
Member Load definitions and assigned to the corresponding members under the selected 
load case.
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8.1 Problem Description

The model is a 17-story building frame structure. The elevation and typical floor plans are shown 
in Figure 8-1. All beams are 24"x24" and of 4 ksi lightweight concrete (115 pcf). All columns are 
30"x30" and of 5 ksi normal weight concrete (145 pcf).

All X beams have a point load of 20k (dead) and 15k (live) located at midspan. All Z beams have 
a uniform load of 2.15k/ft (dead) and 1.75 k/ft (live) over the entire span. Wind loads per UBC are 
also applied in the X direction above the first floor. All columns are fixed at the base and all floors 
are assumed to have a rigid diaphragm.

Figure 8-1 Floor Plan

8.1.1 Procedures

The material and section properties of the columns (normal weight concrete and 30x30 section) 
will be assigned to the DEFAULT values.

To generate the model geometry, we will start with the first floor, draw the four beams along line 
"1" and then copy those beams in the +ve Z-direction, three times, at an offset of 20 ft. This will 
generate the beams along "2", "3", and "4" and all other transverse beams on this floor (using the 
CONNECT JOINTS option).

Once the first floor is drawn, we will then extrude the entire floor in the +ve Y direction, 12 times, 
at an offset of 10 ft. This will generate floors 2 through 13 along with the connecting columns.

Changing to floor 13, we will then extrude the two middle bays (lines "B" - "D", "2" - "3") four 
times, in the +ve Y direction at an offset of 14 ft.

Finally, the columns below the first floor will be generated by drawing the columns at "A1", 
copying it four times in the +ve X direction, and then extruding three times in the +ve Z direction.
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While assigning properties, you may need to rotate the model. This may be done by holding down 
the CTRL key, pressing the left-mouse button, and dragging the mouse. You can see the model 
orientation in the upper portion of the Tool bar. When satisfied with the model orientation, release 
the mouse button and the CTRL key.

8.1.2 Problem Definitions

Choose Define/Units, select the appropriate units, and choose OK. 

Figure 8-2 Define Units

Choose Define/Defaults and input 4080 for E, 145 for d, 900 for A, 67500 for Iz and Iy, 270000 
for J, 0.25 for V, and 0 for a and B. Choose OK. 
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Figure 8-3 Define Defaults

Choose Define/Materials and input ConLW for label. Input 115 for d, 2600 for E, 0.25 for v, 0 for 
a, and choose ADD. The data are added to the list. Choose OK.

Figure 8-4 Define Materials

Choose Define/Sections and input 24x24 for LABEL. Select RECTANGULAR from the TYPE 
list, input 24 for width, 24 for depth, and choose ADD. The data are added to the list. Choose OK. 
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Figure 8-5 Define Sections

Choose Define/Member Loads and input the following entries. Choose ADD after each entry and 
OK when done

W = intensity, a = distance from J1/length, b = load length/length

Choose Define/Load Cases and input Dead, Live, and Wind in the label box, choosing ADD after 
each entry and OK when done.

Label Type Orientation Dir W A b

20K@.3 POINT GLOBAL Y -20 0.3 -

15K@.3 POINT GLOBAL Y -15 0.3 -

2.15U DISTRIBUTED GLOBAL Y -2.15 0 1

1.75U DISTRIBUTED GLOBAL Y -1.75 0 1
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Figure 8-6 Define Load Cases

Choose Define/Load Combinations. In the LABEL box enter 1.4D+1.7L. Select SELF and 
DEAD from the LOAD CASE list, input 1.4 in the FACTOR box, and choose INCLUDE. Select 
LIVE from the LOAD CASE list, input 1.7 in the FACTOR box, and choose INCLUDE. Choose 
ADD. The combination is added to the list at the bottom.

Figure 8-7 Define Load Combinations

In the LABEL box, enter 0.9D+1.3W. Select all items in the FACTORED CASES box and choose 
REMOVE. Select SELF and DEAD from the LOAD CASE list, input 0.9 in the FACTOR box, 
and choose INCLUDE. Select WIND from the LOAD CASE list, input 1.3 in the FACTOR box, 
and choose INCLUDE. Choose ADD. The combination is added to the list at the bottom. Choose 
OK.
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8.2 Drawing the First Floor

In the Main window, choose Edit/Plane. PLANE dialog box appears. Select XZ and choose OK.

Plane window is opened and the CHANGE PLANE dialog box appears. Accept the default label 
and coordinate, and choose ADD. The data are added to the list box. Choose OK. The first floor 
(Y=0) is now the active plane.

Choose Options/Drawing Area, the DRAWING AREA box appears. Enter 0 for MIN, 100 for 
MAX, and 5 for STEP (for both X and Z). Choose OK.

Choose Options/Snap, the SNAP box appears. Enter 5 for X, 5 for Z, and check the SNAP ON 
box. Choose OK.

Choose Edit/Add Member. As you move the cursor, its position is displayed in the left-most cell 
of the Status bar. Note that positive Z is pointing down on the screen.

Point to (0,0) and click the left-mouse button. A joint is inserted and a line follows the cursor. 
Point to (0, 20) and click again. Another joint is inserted and a member is created between the two 
joints.

Click the left button on (0, 40) and (0, 60). The three members along line A are drawn. Click the 
right-mouse button to end.

Choose Duplicate/Select and marquee select all three members (members will be drawn in cyan).

Choose Duplicate/Copy, point to (0, 0) and click; the COPY box appears. Input 25 for HORIZ 
distance, 4 for QUANTITY, check the CONNECT JOINTS box, and leave the other boxes to their 
default values of zero. Choose OK. The rest of the members of this level are generated.

8.2.1 Generating Floors 2 through 13

Choose Duplicate/Select and marquee select all the members on the floor.

Choose Duplicate/Extrude, point to joint (0, 0) and click; the EXTRUDE box appears.

Enter 10 for Y distance, 12 for QUANTITY, check the CONNECT GENERATED JOINTS box, 
and leave the other boxes to their default values of zero. Choose OK. Floors 2 through 13 are 
generated.

8.2.2 Generating Floors 14 through 17

Choose Options/Change Plane. The CHANGE PLANE box appears. From the list box, select 
Y=120 plane and choose OK. This floor is now the active plane.
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Choose Duplicate/Select, and marquee select the members that bound the two bays in the center 
of the floor.

Choose Duplicate/Extrude, point to joint (25, 20) and click; the Extrude box appears.

Enter 14 for Y distance, 4 for QUANTITY, check the CONNECT GENERATED JOINTS box, 
and leave the other boxes to their default values of zero. Choose OK. The top four floors are 
generated.

Choose Options/Exit to return to the Main window where the model may be viewed in 3-D.

8.2.3 Generating Columns Below 1st Floor

Choose Edit/Plane; in the PLANE box, select XY and choose OK.

Choose Options/Drawing Area, the Drawing Area box appears. Enter -15 for Min Y and choose 
Ok.

Plane window is opened and the CHANGE PL ANE box appears. From the generated joints and 
members, all possible XY planes are defined and listed. Select the Z=0 plane and choose OK. The 
elevation along line "1" is now the active plane.

Choose Edit/Add Member. Point to (0, 0) and click the left-mouse button. Point to (0, -15) and 
click. A member is added between the two joints. Click the right-mouse button to end.

Choose Duplicate/Select and marquee the member just drawn.

Choose Duplicate/Copy, point to (0, 0) and click; the COPY box appears. Input 25 for HORIZ 
distance, and 4 for QUANTITY. Clear the CONNECT JOINTS box and choose OK. Four more 
columns are generated.

Choose Duplicate/Select and marquee select the five columns below the first floor.

Choose Duplicate/Extrude, point to joint (0, 0) and click; the EXTRUDE box appears.

Enter 20 for Z distance and 3 for QUANTITY. Clear the CONNECT GENERATED JOINTS box 
and choose OK. The rest of the columns below the first floor are generated.

Choose Option/Exit to close the Plane window and return to the Main window. The model can be 
viewed here in 3-D (you may need to rotate to get a better view).

8.2.4 Assigning Supports

Choose Assign/Supports. The SUPPORTS box appears. Rotate the model so that you are looking 
directly at the XY plane. 

Check the Dx, Dy, Dz, Rx, Ry, and Rz boxes, choose the ASSIGN button, and marquee select the 
joints at the base of the model. The selected joints are shown in red.
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8.2.5 Assigning Member Properties

Choose Assign/Member Types. The MEMBER TYPES box appears. MATERIALS is selected in 
the drop-down list and CONCLW is displayed in the list box. 

Choose Show/Preferences, and in the dialog box, clear COLUMNS, check BEAMS, and choose 
OK. Only beams are displayed. Marquee select all beams in the model. The selected members are 
drawn in red. 

From the drop-down list, select SECTIONS. The list box displays the defined sections. Select 
24x24 from the list and marquee select all the beams.

8.2.6 Assigning Member Loads

Choose Assign/Member Loads. The MEMBER LOADS box appears. DEAD is selected in the 
drop-down list and the defined member loads are displayed in the list box.

Rotate the model so that you are looking directly at the XZ plane (Y is pointing out of the screen 
and X is pointing to the right).

From the list, select 20k@.3 and marquee select the four rows of X-beams, one row at a time. The 
selected members are drawn in red.

From the list, select 2.15U. Note that the X-beams change to black indicating that they have a 
different assignment. Marquee select the five rows of Z beams one row at a time. The selected 
members are drawn in red.

From the drop-down list, select LIVE. From the list box, select 15k@.3. Marquee select the four 
rows of X-beams, one row at a time. From the list box, select 1.75U. Marquee select the five rows 
of Z-beams, one row at a time.

8.2.7 Assigning Self Loads

Choose Assign/Self Loads. Rotate the model to a 3-D view. Choose Show/ Preferences, check the 
COLUMNS and BEAMS boxes, and choose OK. Marquee select all members.

8.2.8 Assigning Rigid Diaphragms

Choose Assign/Rigid Diaphragm. In the RIGID DIAPH box, select ATTACH ALL, and choose 
CLOSE.

8.2.9 Inputting Lateral Loads

Choose Options/Lateral Loads. From the LOAD CASE list, select WIND; in the LOAD TYPE 
group, select WIND; and in the DIRECTION group, select X.
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Figure 8-8 Input Lateral Loads

Choose the PARAMETERS button. A dialog box appears. Input 75 for v, 0.8 for WINDWARD 
Cq, and -0.5 for LEEWARD Cq. Select EXPOSURE B and STANDARD OCCUPANCY and 
choose OK. The wind forces are displayed in the list box. Choose APPLY LOADS, then choose 
CLOSE. 

Figure 8-9 Wind Parameters
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8.2.10 Saving File

Choose File/Save As, select the spFrame file *.FRM for the file type, enter a valid name in the 
FILENAME text box, and choose OK. The file may be opened using spFrame for analysis.
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A.1 Conversion Factors - English to SI

A.2 Conversion Factors - SI to English

To convert from To Multiply by

in. m (1000 mm) 0.025400

ft m 0.304800

lb N (0.001 kN) 4.448222

kip (1000 lbs) kN 4.448222

plf (lb/ft) N/m 14.593904

psi (lb/in.2) kPa 6.894757

ksi (kips/in.2) MPa 6.894757

psf (lb/ft2) N/m2
 (Pa) 47.88026

pcf (lb/ft3) kg/m3
 16.018460

ft-kips kN • m 1.355818

To convert from To Multiply by 

m (1000 mm) in 39.37008 

m ft 3.28084 

N (0.001 kN) lb 0.224809 

kN kip (1000 lbs) 0.224809 

kN/m plf (lb/ft) 68.52601 

MPa psi (lb/in2) 145.0377 

MPa ksi (kips/in2) 0.145038 

kN/m2
 (kPa) psf (lb/ft2) 20.88555 

kg/m3
 pcf (lb/ft3) 0.062428 

kN • m ft-kips 0.737562 
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A.3 Contact Information

Web Site: https://www.StructurePoint.org

E-mail: info@StructurePoint.org

 
support@StructurePoint.org

 
StructurePoint, LLC. 

5420 Old Orchard Road 

Skokie, IL 60077 

USA 

Phone: (847) 966-4357 

Fax: (847) 966-1542 

https://www.structurepoint.org/
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